HP Quality Center Synchronizer

Software Version: 1.30

User Guide
Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor’s standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental information. Site content and availability may change without notice. HP makes no representations or warranties whatsoever as to site content or availability.

Copyright Notices

© Copyright 1993 - 2009 Hewlett-Packard Development Company, L.P.

Trademark Notices

Microsoft®, Windows®, and Windows XP® are U.S registered trademarks of Microsoft Corporation.
Support

You can visit the HP Software Support web site at:

   http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your business. As a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest
• Submit and track support cases and enhancement requests
• Download software patches
• Manage support contracts
• Look up HP support contacts
• Review information about available services
• Enter into discussions with other software customers
• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract.

To find more information about access levels, go to:

   http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:

   http://h20229.www2.hp.com/passport-registration.html
Table of Contents

Chapter 4: Working with Quality Center Synchronizer .....................73
   Viewing Link Details .................................................................74
   Running Link Tasks .................................................................80
   Viewing Task Run History ......................................................84
   Viewing Task Run Reports ......................................................86
   Editing Synchronization Link Settings ......................................90
   Resetting a Link .................................................................91
   Enabling and Disabling Synchronization Links .........................93
   Deleting Synchronization Links ............................................94
   Automatic Backup of the Quality Center Synchronizer Database....95
   Restoring the Quality Center Synchronizer Database .................95
   Exporting and Importing Link Definitions ................................96
   Exporting and Importing Link Data .........................................97
   Configuring the Quality Center Synchronizer Options ..............99
   Changing the Quality Center Synchronizer Password ...............102

Appendix A: Working with Rational ClearQuest ..............................103
   Guidelines for Working with Rational ClearQuest ....................103
   Quality Center Synchronizer Settings for ClearQuest ...............108
   Migrating Links from the Mercury Quality Center
      Defects Synchronizer for Rational ClearQuest ......................110

Appendix B: Working with Rational RequisitePro .............................115
   Guidelines for Working with Rational RequisitePro ..................115
   RequisitePro Connection Properties ......................................116
   Migrating to the Quality Center Synchronizer .......................117
Welcome to This Guide

Welcome to HP Quality Center Synchronizer. Quality Center Synchronizer enables you to synchronize Quality Center data with data in another application. You can synchronize the following:

➤ Requirements between Quality Center and Rational RequisitePro
➤ Defects between Quality Center and Rational ClearQuest
➤ Defects between two Quality Center projects

This guide describes how to create and manage synchronization links, and how to run tasks on these links.

Note: The usage of HP Quality Center Synchronizer or HP Quality Center Synchronizer Adapter SPI to develop an adapter for Quality Center is not supported.

How This Guide is Organized

This guide contains the following chapters:

Chapter 1 Getting Started
Describes how to start the Quality Center Synchronizer and introduces the Quality Center Synchronizer window.
Welcome to This Guide

Chapter 2  Synchronizing at a Glance
Provides an overview of working with the Quality Center Synchronizer.

Chapter 3  Creating Synchronization Links
Describes how to create synchronization links for synchronizing data between Quality Center and other applications, or between two Quality Center projects.

Chapter 4  Working with Quality Center Synchronizer
Describes how to run tasks on synchronization links, manage synchronization links, and configure Quality Center Synchronizer.

Appendix A  Working with Rational ClearQuest
Describes notes and limitations specific to syncing defects with Quality Center Synchronizer and Rational ClearQuest.

Appendix B  Working with Rational RequisitePro
Describes notes and limitations specific to syncing requirements with Quality Center Synchronizer and Rational RequisitePro.

Documentation Set
The Quality Center Synchronizer documentation set includes the following guides and references:

HP Quality Center Synchronizer User Guide explains how to create and manage synchronization links to synchronize data between Quality Center and other applications.

HP Quality Center Synchronizer Installation Guide explains how to install and configure Quality Center Synchronizer.

Readme provides last-minute news and information about Quality Center Synchronizer.
Welcome to This Guide

To access the documentation set:

➤ To access the Quality Center Synchronizer User Guide, from the Synchronizer, select Help > User Guide. Alternatively, select Start > Programs > HP Quality Center Synchronizer Client > User Guide.

➤ For the most up-to-date versions of these documents, see the HP Quality Center Add-ins page. From the main Quality Center window, select Help > Add-ins Page.

➤ All documents are available on the Quality Center installation DVD in the Quality Center Synchronizer folder.
Welcome to This Guide
Getting Started

This chapter explains how to start Quality Center Synchronizer and introduces the Quality Center Synchronizer window.

This chapter includes:
➤ Starting and Stopping the Quality Center Synchronizer Service on page 11
➤ Starting the Quality Center Synchronizer Client on page 13
➤ The Quality Center Synchronizer Client Window on page 16

Starting and Stopping the Quality Center Synchronizer Service

This section describes how to start and stop the Synchronizer service.

Starting the Quality Center Synchronizer Service

You start the Synchronizer service from the Synchronizer server machine. The Synchronizer service must be running to work with the Synchronizer client.

If you encounter problems starting the Synchronizer service, refer to the HP Quality Center Synchronizer Installation Guide for troubleshooting suggestions.

To start the Quality Center Synchronizer service:
On the Synchronizer server machine, choose Start > Programs > HP Quality Center Synchronizer > Start Synchronizer.
Note: The Synchronizer service is started in the background. It may take a few minutes before the Synchronizer client can connect to the server.

Stopping the Quality Center Synchronizer Service

You stop the Synchronizer service from the Synchronizer server machine.

To stop the Quality Center Synchronizer service:

1 Make sure that no tasks are running for any link. You can check whether link tasks are currently running from the Running field in the Links Grid. For more information on the Links Grid, see “Viewing Link Details” on page 74.

Tip: To ensure that no tasks can run on any link, disable all links before you stop the Quality Center Synchronizer service. For more information on disabling links, see “Enabling and Disabling Synchronization Links” on page 93.

2 On the Synchronizer server machine, choose Start > Programs > HP Quality Center Synchronizer > Stop Synchronizer.
Starting the Quality Center Synchronizer Client

After you have installed the Synchronizer server and client, and started the server, you can start the Synchronizer client and connect to the server.

Notes:

➤ You can work with more than one client connected to the server at the same time. To avoid unexpected results, if you work with more than one client, you must make sure that no link is worked on by more than one client at the same time.

➤ The Synchronizer client is automatically disconnected from the Synchronizer server after an extended period of inactivity. For information on reconnecting, see “Disconnecting from and Reconnecting to the Quality Center Synchronizer Server” on page 14.

To start the Quality Center Synchronizer client:

1 On the Synchronizer client machine, choose Start > Programs > HP Quality Center Synchronizer Client > Quality Center Synchronizer Client. The Connect to Server dialog box opens.

2 In the Server name box, type the machine name of the Synchronizer server to which you want to connect.

3 In the Password box, type the password for the Synchronizer server. The initial password is blank.
Chapter 1 • Getting Started

**Note:** To increase the security of your Quality Center Synchronizer data, change the password from the default blank password as soon as possible. For more information on changing the server password, see “Changing the Quality Center Synchronizer Password” on page 102.

4 Click **Connect**. The Synchronizer connects to the server you specified and the Synchronizer client opens.

**Tip:** To close the Synchronizer client, choose **Connection > Exit**.

**Disconnecting from and Reconnecting to the Quality Center Synchronizer Server**

You can disconnect from the Synchronizer server manually when needed. For example, you may want to connect to a different server. Additionally, if you receive a warning that the Synchronizer client is not connected to the server, you need to manually disconnect from the Synchronizer server. This can occur, for example, after an extended period of inactivity.

After you disconnect from a server, you must connect to another server or reconnect to the same server to continue working with the Synchronizer.
To disconnect from and reconnect to a Quality Center Synchronizer server:

1. Select **Connection > Disconnect**, or click the **Disconnect** button. The Connect to Server dialog box opens.

2. Click the **Disconnect** button. The **Server name** and **Password** boxes become editable.

3. Enter the logon credentials as described in step 2 in “Starting the Quality Center Synchronizer Client” on page 13.

4. Click the **Connect** button. The Synchronizer connects to the server you specified and the Synchronizer client opens.
The Quality Center Synchronizer Client Window

The Synchronizer client enables you to manage the synchronization links stored in the Synchronizer database. For more information on starting the Synchronizer client, see “Starting the Quality Center Synchronizer Client” on page 13.

The Synchronizer client window contains the following key elements:

➤ **Quality Center Synchronizer menu bar.** Contains drop-down menus of the Synchronizer commands.

➤ **Quality Center Synchronizer toolbar.** Contains buttons of commands commonly used when managing synchronization links.

➤ **Links list.** Contains a list of the synchronization links available on the Synchronizer server. Located on the left of the Synchronizer client window.

➤ **Link Details pane.** Contains information about your synchronization links. Located on the upper right of the Synchronizer client window.

➤ **Execution pane.** Contains information about link task execution. Located on the bottom right of the Synchronizer client window.
Synchronizing at a Glance

This chapter provides an overview of synchronizing data and describes the Quality Center Synchronizer infrastructure.

**This chapter includes:**
- About Synchronizing at a Glance on page 17
- Synchronization Links on page 18
- Integrity Checks on page 20
- Incremental Synchronizations on page 25
- Full Synchronizations on page 26
- Working with Quality Center Version Control on page 27

**About Synchronizing at a Glance**

The Synchronizer enables you to synchronize data between Quality Center and other applications, or between two Quality Center projects.

To manage synchronization between applications, you create synchronization links. Synchronization links define which data is synchronized and how it is synchronized. For more information on synchronization links, see “Synchronization Links” on page 18.

After you create a synchronization link, you run an integrity check to validate the link and to highlight problems that may occur during synchronization. For more information on integrity checks, see “Integrity Checks” on page 20.
You can run two types of synchronization: incremental synchronizations and full synchronizations. For more information on these synchronization types, see “Incremental Synchronizations” on page 25 and “Full Synchronizations” on page 26.

The following Quality Center data is not synchronized: history, test coverage, requirements traceability, and defect linkage.

**Synchronization Links**

You create synchronization links between two endpoints. An **endpoint** is an application containing data that is synchronized by the Synchronizer. The first endpoint is always an instance of Quality Center, while the second endpoint is another application such as Rational ClearQuest or Rational RequisitePro.

A **synchronization link** or **link** defines which entities are included in the synchronization, and how the synchronization is performed. For example, you can define whether the Synchronizer synchronizes only new records that were added since the last synchronization, or also synchronizes existing records that were updated. You also define which fields and field values in one endpoint are mapped to corresponding fields and field values in the other endpoint.

For a mapping between fields or field values, the **source** endpoint refers to the endpoint from which data is synchronized. Data in the source endpoint for the mapping remains unchanged. The **destination** endpoint refers to the endpoint to which data is synchronized. Data in the destination endpoint is updated according to the data in the source endpoint and the mapping’s settings.

Each link contains information to determine which data to synchronize and how to perform the synchronization. For more details on the information contained in links, see “Time Stamp, Identity Mappings, and Record Versions” on page 19 and “Cycle Redundancy Checks” on page 19.
Time Stamp, Identity Mappings, and Record Versions

The Synchronizer stores various data during the synchronization process. During subsequent synchronization runs, the Synchronizer uses this data to determine if a record needs to be synchronized. The stored data includes:

- **Time stamp.** Indicates when the last synchronization task started running on a specific link.

- **Identity mappings.** For each link, the Synchronizer stores a table of identity mappings between records in each endpoint. Each record in each endpoint is identified by a unique ID, and this table records the correspondence between each pair of records.

- **Record versions.** Indicates the version of each synchronized record in each endpoint. During synchronization, each synchronized record receives a unique version.

Cycle Redundancy Checks

After the Synchronizer has determined that a mapping is a candidate for synchronization, a cycle redundancy check (CRC) is performed to determine whether to synchronize the records in the mapping. A cycle redundancy check is a mathematical operation used to indicate whether data in an endpoint has changed.

The Synchronizer performs a cycle redundancy check for each endpoint on the mapped fields only. This enables the Synchronizer to determine whether the modifications made to the records in the mapping necessitate synchronizing the records.

For example, suppose you are mapping defects in Quality Center with defects in ClearQuest, and the only field mapping for the link is between the **Status** field in Quality Center and the **State** field in ClearQuest. Suppose the **Priority** field is updated for a defect in Quality Center. As the defect was modified, the mapping that includes the defect is a candidate for synchronization, based on the link time stamp. However, as the mapped fields were not modified, the records should not be synchronized, even though there were other modifications to the records. During synchronization, the Synchronizer performs a cycle redundancy check on the mapping. The check indicates that the mapped fields were not modified, and therefore the records are not synchronized.
**Chapter 2 • Synchronizing at a Glance**

**Integrity Checks**

An **integrity check** identifies possible problems that can occur during the synchronization process. You must run an integrity check on a link before you can run a synchronization task on that link. When an integrity check passes successfully, you can enable the link and run synchronization tasks on it.

You run an integrity check to validate a link when you:

➤ Create a new link
➤ Modify an existing link
➤ Modify the schema for one of the link's endpoints

An integrity check verifies both general settings for the link, and the field mappings defined for the link. Each individual check within the integrity check can **pass** or **fail**. The integrity check passes only if none of the individual checks within it fail.

If you do not run an integrity check, or if the integrity check does not pass, the link remains **unvalidated** and cannot be enabled for synchronization.

The Synchronizer generates a report for each run, which you can open by clicking the **View Report** button in Execution pane (in the lower part of the Synchronizer window). After an unsuccessful integrity check run, you can review this report to identify which individual checks failed and to determine how to fix the link. After the link is fixed, run the integrity check again.

This section includes the following topics:

➤ “Checks Performed on General Link Settings” on page 21
➤ “Checks Performed on Link Field Mappings” on page 23
## Checks Performed on General Link Settings

The following table displays which checks the Synchronizer performs for each endpoint when you run an integrity check. Depending on the entity type synchronized in the link, not all of these checks are performed for every link.

<table>
<thead>
<tr>
<th>Check Name</th>
<th>Check Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Connection</td>
<td>Checks that the Synchronizer can successfully connect to the endpoint using the settings defined.</td>
</tr>
<tr>
<td>User permission check</td>
<td>Checks that the user used to connect to the endpoint has sufficient permissions to perform the required tasks.</td>
</tr>
<tr>
<td>Quality Center Premier License check</td>
<td>For a link between two Quality Center endpoints only. Checks that the endpoint is Quality Center Premier Edition.</td>
</tr>
<tr>
<td>Endpoint parameters check</td>
<td>Checks and validates additional parameters that may be defined for the endpoint. For example, if an alternate root folder is defined for requirements synchronization, checks that the folder exists in Quality Center.</td>
</tr>
<tr>
<td>Fetching endpoint schema</td>
<td>Checks that the Synchronizer can obtain the database schema for the endpoint.</td>
</tr>
<tr>
<td><code>&lt;requirement type&gt; Subtype: Mapped fields check</code></td>
<td>Performs checks on fields that are mapped for the endpoint.</td>
</tr>
<tr>
<td>Specified filter exists</td>
<td>If a filter is defined for the endpoint in the link, checks that the filter exists in the endpoint.</td>
</tr>
<tr>
<td>Subtype exists check</td>
<td>Checks that the mapped requirement type exists in the endpoint.</td>
</tr>
</tbody>
</table>
### Chapter 2 • Synchronizing at a Glance

<table>
<thead>
<tr>
<th>Check Name</th>
<th>Check Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Endpoint events check</strong></td>
<td>Checks the following:</td>
</tr>
<tr>
<td></td>
<td>➤ If the endpoint is set to handle record creation in the other endpoint, it is also set to update the other endpoint.</td>
</tr>
<tr>
<td></td>
<td>➤ If the endpoint is set to recreate records, the other endpoint is set to handle record creation.</td>
</tr>
<tr>
<td></td>
<td>➤ One endpoint only is set to handle record creation for the mapped requirement type.</td>
</tr>
<tr>
<td>Fields mapping defined</td>
<td>Checks that a field mapping is defined between the endpoints and that it can be obtained by the Synchronizer.</td>
</tr>
<tr>
<td>Consistency of mapping and</td>
<td>Checks that if a field mapping is defined from the endpoint, the link is set to handle record creation or updates in the other endpoint. Also checks</td>
</tr>
<tr>
<td>endpoint events</td>
<td>that if the link is set to handle record creation or updates in the endpoint, a field mapping is defined to the endpoint.</td>
</tr>
</tbody>
</table>
### Checks Performed on Link Field Mappings

An integrity check performs the following checks on the field mappings you define for the link. The Synchronizer also performs these checks when you check the field mappings when you create or configure a link. Depending on the type of field mapped, not all of these checks are performed for every identity mapping.

<table>
<thead>
<tr>
<th>Check Name</th>
<th>Check Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required fields check</td>
<td>Checks that required fields in the destination endpoint are mapped to a field in the source endpoint, or are assigned a constant value. If this is not the case, the check fails.</td>
</tr>
<tr>
<td></td>
<td>In addition, checks that recommended fields in the destination endpoint are mapped to a field in the source endpoint, or are assigned a constant value. If this is not the case, the check passes with a warning.</td>
</tr>
<tr>
<td>Field existence check</td>
<td>Checks that the field exists in the endpoint.</td>
</tr>
<tr>
<td>Field types match check</td>
<td>Checks that if a mapping exists between fields of different types, the values can be converted between the types.</td>
</tr>
<tr>
<td>Fields length match check</td>
<td>For string type fields (<em>String, Multi value list, Single value list, User list</em>), checks that the maximum length for values for each of the fields in a mapping is the same. If the maximum length is different, the check passes with a warning that some values may be truncated.</td>
</tr>
<tr>
<td>Fixed list mapping check</td>
<td>Checks whether the source field of a mapping is not a verified list field, whereas the destination field is a verified list field. In such a case, the check passes with a warning as it is possible that values will be mapped to the destination that are not in its list.</td>
</tr>
<tr>
<td>User list check</td>
<td>Checks whether the source field of a mapping is not a user list field, whereas the destination field is a user list field. In such a case, the check passes with a warning as it is possible that values will be mapped to the destination that are not in its user list.</td>
</tr>
</tbody>
</table>
### Chapter 2 • Synchronizing at a Glance

<table>
<thead>
<tr>
<th>Check Name</th>
<th>Check Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value mapping types check</td>
<td>Checks that it is possible to convert between the type of the value mapped to a field and the type of the field.</td>
</tr>
<tr>
<td>Values length match check</td>
<td>For string type fields (String, Multi value list, Single value list, User list), checks that the length of values mapped to the field in a field value mapping is not greater than the maximum length for the field. If a value is mapped that is longer than the maximum length, the check passes with a warning that the value will be truncated.</td>
</tr>
<tr>
<td>Values mapping in mandatory field check</td>
<td>Checks that no field value mapping maps an empty string to a mandatory field.</td>
</tr>
<tr>
<td>Fixed list values mapping check</td>
<td>Checks that no field value mapping exists that maps values to a verified list field that are not in the list associated with the destination field.</td>
</tr>
<tr>
<td>Read only check</td>
<td>Checks that there is no mapping to read-only fields.</td>
</tr>
</tbody>
</table>
Incremental Synchronizations

You run an incremental synchronization on a link to determine which records in the endpoints were created or modified since the previous synchronization task, and then synchronize data between the two endpoints according to the mapping and settings you defined for the link.

➤ In an incremental synchronization, the Synchronizer first sends a request to each endpoint to supply a list of records created or modified since the time indicated by the time stamp for the link. The time stamp for a link is the time the last synchronization task started running. The endpoint supplies this list by comparing the time stamp for the link with the time each record was last modified as recorded by the endpoint. If a record was modified after the time indicated by the time stamp for the link, it is included in the list.

➤ If a record that is included in the list for one of the endpoints is not previously known to the Synchronizer, and therefore does not appear in the identity map table for the link, the Synchronizer infers that the record was created after the last synchronization. If you enabled record creation in the other endpoint, the Synchronizer creates a corresponding record in that endpoint and updates the identity map table to include this correspondence.

➤ If a record in the list already appears in the identity map table for the link, and the record's version is different from the version in the identity mapping record, the Synchronizer infers that the record has been updated since the last synchronization. The Synchronizer then performs a cycle redundancy check to determine if fields included in the mapping were modified and require synchronization. If synchronization is necessary, the Synchronizer updates the corresponding record in the other endpoint, depending on the settings for the link.
An incremental synchronization does not handle deleted records. In addition, it can cause data consistency issues. For example, consistency issues could arise if the Synchronizer tries to update a record but is unable to do so for some reason, such as the record being locked in the endpoint. In such a case, the Synchronizer updates the time stamp for the link even though the records have not been synchronized. In future synchronizations, the Synchronizer will not detect that these records still need to be synchronized. To handle deleted records and data consistency issues, you can run a full synchronization. For more information, see “Full Synchronizations” on page 26.

Full Synchronizations

You can run a full synchronization to perform a full comparison of the records in each endpoint. This is useful if you want to handle records that were deleted from one of the endpoints, or if you want to synchronize records that were not synchronized in an incremental synchronization.

In a full synchronization, the Synchronizer requests from each endpoint a list of all the records in that endpoint, not just those created or modified since the previous synchronization task. It then compares this list of records with the list of records included in the identity mapping table. If a record appears in the identity mapping table but no longer appears in the endpoint, the Synchronizer infers that the record was deleted from the endpoint and deals with this case according to the options specified in the link’s configuration.

If a record appears in both the endpoint and the identity mapping table for the link, the Synchronizer synchronizes the record based on the link’s time stamp, the record’s version, and the cycle redundancy checks, as it would in an incremental synchronization. However, some records may be synchronized that would not otherwise be synchronized in an incremental synchronization. This is because in a full synchronization, all records are requested from each endpoint, and not just those modified since the previous synchronization task.
Working with Quality Center Version Control

This section explains how the Quality Center Synchronizer handles requirements synchronization with a Quality Center version control enabled project. This is relevant only for a Quality Center 10.00 project. For more information on working with version control in Quality Center, refer to the *HP Quality Center User Guide*.

Consider the following when synchronizing requirements with a Quality Center version control enabled project:

- When a requirement is created in the Quality Center endpoint during synchronization, it is created with a checked in status. A comment is added to the requirement's version history specifying that this requirement was created automatically.

- When a requirement is updated in the Quality Center endpoint during synchronization, the Synchronizer creates and checks in a new version of the requirement. A comment is added to the requirement's version history specifying that the requirement was modified by the Quality Center Synchronizer.

- When synchronizing a requirement that is checked out by the Quality Center user defined for the link, the requirement is updated and the new version of the requirement is checked in.

- A requirement checked out by a Quality Center user other than the user defined for the link is not synchronized.
Creating Synchronization Links

You create synchronization links to synchronize data between Quality Center and another endpoint.

This chapter includes:
➤ About Creating Synchronization Links on page 30
➤ Creating Links on page 31
➤ Setting Link Properties on page 38
➤ Setting Scheduling Options on page 42
➤ Setting Filter Options on page 44
➤ Creating Requirement Type Mappings on page 47
➤ Setting Event Options on page 49
➤ Creating Field Mappings on page 54
➤ Setting Mail Notifications on page 70
➤ Setting Adapter Parameters on page 71
Chapter 3 • Creating Synchronization Links

About Creating Synchronization Links

You create synchronization links from the Synchronizer client. The link defines synchronization of defects or requirements between Quality Center and another endpoint.

Creating synchronization links involves the following stages:

1. Determine basic settings for the link and define its endpoints. For more information, see “Creating Links” on page 31.

2. Confirm the basic settings and define additional general settings. For more information, see “Setting Link Properties” on page 38.

3. Define whether synchronizations will be run manually, or automatically at regular time intervals. For more information, see “Setting Scheduling Options” on page 42.

4. Define which records created in an endpoint are synchronized. For more information, see “Setting Filter Options” on page 44.

5. If you are synchronizing requirements, create mappings between requirement types in the endpoints. For more information, see “Creating Requirement Type Mappings” on page 47.

6. Define which types of changes to data in an endpoint are synchronized. You can synchronize records added since the previous synchronization, records updated since the previous synchronization, or records deleted since the previous full synchronization. For more information, see “Setting Event Options” on page 49.

7. Define how fields are mapped between the two endpoints. You can also map specific field values in one endpoint to fields values in the other endpoint. For more information, see “Creating Field Mappings” on page 54.

8. Run an integrity check to verify the settings and mappings for the link. For information on integrity checks, see “Integrity Checks” on page 20. For information on running an integrity check, see “Running Link Tasks Manually” on page 82.

9. Save the link by clicking the Save button. Click Yes to confirm. This saves the link and converts it to read-only mode. To edit the link configuration again, click the Edit button.
Creating Links

The Quality Center Synchronizer provides a wizard that enables you to create a link. For each link, you assign a name and description, and define its two endpoints. One endpoint is always a Quality Center instance. The other endpoint is the project in the application you want to synchronize. You also define which type of entity to synchronize in each endpoint, such as defects or requirements. Each link can synchronize only one entity type in each endpoint. The entity types you choose determine which fields are available for synchronization in each endpoint, based on the database schema for the types in their endpoints.

You can create only one synchronization link between the same entity types in the same two endpoints, and each synchronization link must be unique. The uniqueness of a link is defined by its connection data. This means that you can create as many links as needed to one Quality Center project, as long as the other endpoints are all unique. For example:

Quality Center/MyProject  <->  RequisitePro/Project_A
Quality Center/MyProject  <->  RequisitePro/Project_B

In this example, the pair of endpoints for each link are unique, so you can create these synchronization links.

If you then try to create another synchronization link using Quality Center/MyProject  <->  RequisitePro/Project_B as endpoints, the link creation fails because the projects in both endpoints are already paired in an existing link.
To create a link:

1. Select Link > Create or click the Create Link button. The Create Link wizard opens to the General Properties dialog box.

2. Define the general link properties:
   - In the Link name box, type a name for the link.
   - In the Description box, type a description for the link.
   - In the Endpoint 2 type box, select the application you want to synchronize with Quality Center.
3 Click **Next**. The Quality Center Endpoint dialog box opens.

Specify connection settings for the Quality Center endpoint:

- To connect to Quality Center and select a project from the list of available domains and projects, click **Set Connection**.
- To enter connection settings manually, proceed to step 9.
The Quality Center Connection dialog box opens.

4 In the Server URL box, type the URL for the Quality Center server in the following format: http://<Quality Center server name>[:<port number>]qcbin. Click Connect. The Authenticate Quality Center User options are enabled.

5 In the Login Name box, type the user name for a Quality Center user. This user must have create, modify, and delete permissions for the entity being synchronized (defect or requirement) in the Quality Center project.

6 In the Password box, type the Quality Center password for the user. Click Authenticate. The Log in to Quality Center Project options are enabled.

7 In the Domain and Project boxes, select the domain and project whose data you want to synchronize.

8 Click OK to close the Quality Center Connection dialog box, and proceed to step 10.
Enter the connection settings for the Quality Center project:

- **User name.** The user name for a Quality Center user. This user must have create, modify, and delete permissions for the entity being synchronized (defect or requirement) in the Quality Center project.

- **Password.** The password for the user you specified.

- **ServerURL.** The URL of the Quality Center server. For example, http://MyServer:8080/qcbin.

- **Domain.** The domain containing the project whose data you want to synchronize.

- **Project.** The name of the project whose data you want to synchronize.

For more details on Quality Center servers, domains, and projects, refer to the *HP Quality Center Administrator Guide*.

To verify the connection to the Quality Center project, click the **Check Connectivity** button. For example, you may want to test the connectivity to several projects before finalizing a project for this link. If the Synchronizer is able to connect to the project, a confirmation message displays.

**Tip:** If you encounter problems connecting to an endpoint, refer to the *HP Quality Center Synchronizer Installation Guide* for troubleshooting suggestions.
Chapter 3 • Creating Synchronization Links

11 Click **Next**. The Synchronizer tries to connect to the Quality Center project and retrieve the available entity types. If successful, the <Endpoint Application> Endpoint dialog box opens.

12 Enter the connection settings for the endpoint you want to synchronize with Quality Center. The settings available depend on which type of endpoint you are working with. For details on the settings available for a particular endpoint, see:
   ➤ “RequisitePro Connection Properties” on page 116.
   ➤ “ClearQuest Connection Properties” on page 109.
   ➤ For Quality Center connection settings, refer to steps 3 - 7 above.

13 Click the **Check Connectivity** button if you want to verify the connection to the project in the application you are synchronizing with the Quality Center entities. For example, you may want to test the connectivity to several projects before finalizing a project for this link. If the Synchronizer can connect to the project, a confirmation message displays.
14 Click Next. The Synchronizer tries to connect to the endpoint project and retrieve the available record entity types. If successful, the Entity Types dialog box opens.

15 In the **Available entity type pairs** box, select the entity type pair you want to synchronize.

16 Click Finish. A message box opens, prompting you to select one of the following options:

- Click **Yes** to begin configuring the link. For more information, see “Setting Link Properties” on page 38.

- Click **No** to open the link in read-only mode.

  **Tip:** If you choose to open the link in read-only mode, you can edit the link later by clicking the **Edit** button.
Chapter 3 • Creating Synchronization Links

Setting Link Properties

After you have defined the link name, description, and endpoints, you define the basic properties for the link.

To set properties for a link:

1. Create the link and define its connection settings as described in “Creating Links” on page 31.

2. In the Links list, select the link you created. The General tab is displayed.

3. Review the link details. To edit or set additional link properties, click the Edit button. For more information on editing links, see “Editing Synchronization Link Settings” on page 90.
Under **General Details**, you can edit the following fields:

➤ In the **Link name** box, edit the name of the link.

➤ In the **Link description** box, edit the description of the link.

4 Under **Endpoint 1** and **Endpoint 2**, in the **Name** box, you can edit the name for the endpoint. The Synchronizer displays this name to identify the endpoint in the other tabs and in reports for the link.

5 Click the **Connectivity** tab.

6 You can edit the settings used to connect to each endpoint. This is useful, for example, if the logon credentials change. For more information on these settings, see “Creating Links” on page 31.

7 To check the connection to an endpoint, click the **Check Connectivity** button for the endpoint. If the Synchronizer can connect to the endpoint, a confirmation message displays.
Chapter 3 • Creating Synchronization Links

8 If you are synchronizing requirements, you can specify an alternate root folder for synchronization under the Quality Center requirements tree. Select **Use alternate root folder** and enter the path of the root folder you want to synchronize.

---

**Important:** Specifying an alternate root folder can cause unexpected behavior. Review “Guidelines for Defining an Alternate Root Folder in Quality Center” on page 41 before specifying an alternate root folder.

---

9 You can now define the scheduling options for the link, including how and when you want to run tasks for the link. For more information, see “Setting Scheduling Options” on page 42.
Guidelines for Defining an Alternate Root Folder in Quality Center

By default, the Synchronizer synchronizes all requirements in the Quality Center Requirements root folder.

You can specify an alternate root folder if you want to synchronize only a subset of the requirements in your Quality Center project. For example, you may want to synchronize multiple projects from the RequisitePro endpoint to different folders in one Quality Center project, as shown in the following illustration.

In the example above, the requirements in the RequisitePro endpoint's Project 2 are synchronized with the requirements in the Quality Center RP_Project 2 folder instead of the Requirements folder.

Consider the following when specifying an alternate root folder.

➤ The path you specify must replicate the exact hierarchy in Quality Center. For example: Requirements\MyProject (Note that Requirements is already defined for you in the dialog box.)
   Tip: You can copy/paste each folder name to ensure exact spelling.

➤ The path of the alternate root folder must be completely different from the path of any other link. For example, if you specify an alternate folder for one link, you can specify a sibling folder for a different link.
Chapter 3 • Creating Synchronization Links

➤ If you want to reorganize the requirements in the Requirements module after one or more synchronization tasks are performed, carefully move requirements while retaining the same hierarchy, instead of deleting requirements and creating new ones. The Synchronizer synchronizes Quality Center requirements according to their Quality Center ID. Moving the requirements maintains the requirement ID and helps prevent requirements from being added or deleted during a synchronization task.

Setting Scheduling Options

After you define the general properties for a link, you determine its scheduling options. If you do not determine scheduling options for a link, link tasks do not run automatically and you must run these tasks manually from the Synchronizer client.

To set scheduling options for a link:

1 Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2 Click the Scheduling tab.
3 Select **Enable scheduling** to enable scheduling of link tasks.

4 Select **Run incremental synchronization task** to run incremental synchronization tasks automatically for the link. For more information on incremental synchronization tasks, see “Incremental Synchronizations” on page 25. The following options are available:

➤ **Schedule every.** Runs incremental synchronization tasks for the link at the specified time interval. The time interval can be specified in minutes or hours. The first time interval starts when you start the Synchronizer server. By default, the time interval is set to 30 minutes for defects synchronization, and 8 hours for requirements synchronization.

**Note:** You cannot schedule an incremental synchronization to run more frequently than five minutes.

➤ **Run task at.** Runs incremental synchronization tasks on the link at the specified time each day. By default, tasks run every day.

Click the browse button to open the Days of Week dialog box, and select specific days of the week to run the task. On these days, the tasks will run at the time you specified in the **Run task at** option.
5 Select Run full synchronization task to run full synchronization tasks automatically for the link. For more information on full synchronization tasks, see “Full Synchronizations” on page 26. The following options are available:

- **Schedule every.** Runs full synchronization tasks for the link at the specified time interval. The time interval can be specified in hours or days. The first time interval starts when you start the Synchronizer server.
  
  **Note:** You cannot schedule a full synchronization to run more frequently than every hour.

- **Run task at.** Runs full synchronization tasks on the link at the specified time each day. By default, tasks run every day.
  
  Click the browse button to open the Days of Week dialog box, and select specific days of the week to run the task. On these days, the tasks will run at the time you specified in the Run task at option. For an illustration of the Days of Week dialog box, see step 4 above.

6 You can now define the filters for the link. For more information, see “Setting Filter Options” on page 44.

**Setting Filter Options**

After you define the general properties for a link and its scheduling options, you can define filters to be used during synchronization. When the Synchronizer looks for new records that have been created in the endpoints since the last synchronization, it includes only records that match the selected filters.

Records that have already been mapped are always synchronized, even if the filter for the endpoint changes or if they no longer match the filter.
Note: The Synchronizer does not automatically refresh the list of filters displayed, as this may take some time. To display the current list of filters available in the endpoints, in the Filters tab, click Refresh Filter Lists. This refresh process also refreshes the endpoint field schemas that are displayed in the Field Mapping tab.

To set filters for a defects synchronization link:

1. Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2. Click the Filters tab. The filter options are displayed, according to the entity type you are synchronizing.

3. For defects synchronization, the Filters tab displays the following filter options.

For each endpoint, select one of the following options:

- **No filter.** All records are considered for synchronization.

- **Use filter (for creation events).** Select a filter from the list. Only records that match the selected filter are considered for synchronization.

4. You can now define which types of changes to data in the endpoints are synchronized. For more information, see “Setting Event Options” on page 49.
Chapter 3 • Creating Synchronization Links

To set filters for a requirements synchronization link:

1 Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2 Click the Filters tab. The filter options are displayed, according to the entity type you are synchronizing.

3 For requirements synchronization, the Filters tab displays the following filter options.

For each endpoint, select one of the following options:

➤ **No filters.** All records are considered for synchronization.

➤ **Use filters (for creation events).** Records that match any of the selected filters are considered for synchronization. Note that selected filters apply only to the requirement type with which they are associated.

   ➤ To add a filter, click the Add button. In the Add Filter dialog box, select the filter and click OK. The filter is added to the list. To add an additional filter, click the Add button.

   ➤ To remove a filter, select the filter from the list and click the Remove button.

4 You can now define mappings between requirement types in the endpoints. For more information, see “Creating Requirement Type Mappings” on page 47.
Creating Requirement Type Mappings

When synchronizing requirements, you create mappings between requirement types in each endpoint. For example, you might map the Functional requirement type in Quality Center to the Functional requirement type in RequisitePro.

Consider the following points when creating requirement type mappings:

➤ Each requirement type in an endpoint can be mapped only once to a requirement type in the other endpoint. Records for requirement types that are not mapped are not synchronized.

➤ For each requirement type mapping, new requirements created in one endpoint only are synchronized. For more information, see “Setting Event Options for Requirements Synchronization” on page 51.

➤ Folders are automatically mapped if they contain a requirement type that is mapped. They cannot be configured.

For more information on synchronizing requirements between Quality Center and another endpoint, refer to the appropriate appendix for that endpoint.

To create requirement type mappings for a link:

1 Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.
Chapter 3 • Creating Synchronization Links

2 Click the Subtype Mapping tab.

![Subtype Mapping](image)

3 In each of the endpoint-type panes on the left, select one requirement type that you want to map. In the example above, Functional and Functional are selected.

4 Click Add Mapping to create the requirement type mapping between the endpoints. The new mapping is displayed in the Mapped Subtypes box.

5 To create additional requirement type mappings, repeat steps 3 to 4.

6 To delete a requirement type mapping, under Mapped Subtypes, select the mapping and click the Delete button.

**Note:** Deleting a requirement type mapping deletes all associated link data for the requirement type's records in both endpoints. For additional important information, see “Deleting Synchronization Links” on page 94.

7 You can now define which types of changes to data are synchronized in the endpoints. For more information, see “Setting Event Options” on page 49.
Setting Event Options

You set event options to direct the Synchronizer how to handle the creation, update, and deletion of records in the endpoints. This section includes:

➤ “Setting Event Options for Defects Synchronization” on page 49
➤ “Setting Event Options for Requirements Synchronization” on page 51

Setting Event Options for Defects Synchronization

After you define basic properties for the link, and set scheduling and filter options, you define which type of synchronization is performed on each endpoint.

To set event options for defects synchronization:

1 Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2 Click the Events tab.
Chapter 3 • Creating Synchronization Links

3 For each endpoint, under **Creation**, select how to handle records created in the endpoint. The following options are available:

- **Create a corresponding record in the other endpoint.** If a record is created in the endpoint, a corresponding record is created in the other endpoint.
- **Do nothing.** No action is taken in the other endpoint in response to records created in the endpoint.

4 For each endpoint, under **Update**, select how to handle records updated in the endpoint. The following options are available:

- **Update its corresponding record in the other endpoint.** If a record that was previously synchronized is updated in the endpoint, the corresponding record is updated in the other endpoint.
  
  You must select this option if the **Create a corresponding record in the other endpoint** option is selected for the endpoint.
- **Do nothing.** No action is taken in the other endpoint in response to records updated in the endpoint.

5 For each endpoint, under **Deletion (Full Synchronization Only)**, specify how to handle records deleted in the endpoint. The following options are available:

- **Do nothing.** No action is taken in the other endpoint in response to records deleted in the endpoint.
- **Delete its corresponding record in the other endpoint.** If a record that was previously synchronized is deleted in the endpoint, the Synchronizer deletes the corresponding record in the other endpoint.
- **Recreate based on its corresponding record in the other endpoint.** If a record that was previously synchronized is deleted in one endpoint, the Synchronizer recreates the record based on the data for the corresponding record in the other endpoint.
  
  This option is available only if **Create a corresponding record in the other endpoint** is selected in the other endpoint.

Note that the Synchronizer handles deleted records only during full synchronization tasks, and not during incremental synchronization tasks.
You can now define how data fields and field values are mapped between the endpoints. For more information, see “Creating Field Mappings” on page 54.

**Setting Event Options for Requirements Synchronization**

After you define basic properties for the link, set scheduling and filter options, and create requirement type mappings, you define which type of synchronization is performed on each endpoint.

For each requirement type mapping, one endpoint is selected as master for the synchronization of records. The event options for the master and non-master endpoints are summarized in the following table:

<table>
<thead>
<tr>
<th>Event</th>
<th>Event Options for Master Endpoint</th>
<th>Event Options for the Non-master Endpoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation</td>
<td>When a record is created in the master endpoint, a corresponding record is created in the other endpoint.</td>
<td>When a record is created in this endpoint, no action is taken in the other endpoint.</td>
</tr>
</tbody>
</table>
| Update  | When a record is updated in the master endpoint, its corresponding record in the other endpoint is updated. | When a record is updated in this endpoint, the following options are available:  
  ➤ No action is taken in the other endpoint.  
  ➤ The corresponding record in the other endpoint is updated. |
| Deletion | When a record is deleted in the master endpoint, the following options are available:  
  ➤ No action is taken in the other endpoint.  
  ➤ The corresponding record in the other endpoint is deleted. | When a record is deleted in this endpoint, the following options are available:  
  ➤ No action is taken in the other endpoint.  
  ➤ The record is recreated based on its corresponding record in the other endpoint. |
The Synchronizer maintains the hierarchical requirements tree structure during synchronization, based on the master endpoint. Consider the following ways in which the Synchronizer handles the parent/child relationship between requirements during synchronization:

➤ When a new requirement is created in the master endpoint, and the requirement is the child of requirements that were not previously synchronized, the parent requirements are also created in the other endpoint. If a filter is defined, the parent requirements are synchronized even if they do not match the filter.

➤ If a requirement is moved within the requirements tree of the master endpoint, it is moved accordingly in the other endpoint.

➤ If you selected an alternate root folder for requirements synchronization in the Connectivity tab, a requirement that you move out of the specified root folder is handled as a deleted requirement.

➤ If a parent requirement is deleted in the master endpoint, and the option to delete corresponding records in the other endpoint is selected, the parent requirement and all child requirements are deleted in the other endpoint.

➤ When a deleted parent requirement is recreated in an endpoint, the child requirements are also recreated.

To set event options for requirements synchronization:

1 Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2 In the Subtype Mapping tab, under Mapped Subtypes, select the mapping you want to configure and click Configure.

Alternatively, in the Links list, expand a requirement link, select the requirement type mapping, and click the Events tab.
Chapter 3 • Creating Synchronization Links

The event options are displayed.

3 To select a master endpoint, click Master (controls record creation and deletion) under the relevant endpoint name. Event options associated with the selection of the master endpoint are set.

4 For the master endpoint, under Deletion, select how to handle records deleted in the endpoint. The following options are available:
   - **Do nothing.** No action is taken in the other endpoint in response to records deleted in the endpoint.
   - **Delete its corresponding record in the other endpoint.** If a record that was previously synchronized is deleted in the endpoint, the Synchronizer deletes the corresponding record in the other endpoint.

5 For the non-master endpoint, under Update, select how to handle records updated in the endpoint. The following options are available:
   - **Update its corresponding record in the other endpoint.** If a record that was previously synchronized is updated in the endpoint, the corresponding record is updated in the other endpoint.
   - **Do nothing.** No action is taken in the other endpoint in response to records updated in the endpoint.
For the non-master endpoint, under **Deletion**, select how to handle records deleted in the endpoint. The following options are available:

- **Do nothing.** No action is taken in the other endpoint in response to records deleted in the endpoint.

- **Recreate based on its corresponding record in the other endpoint.** This option is available only if **Create a corresponding record in the other endpoint** is selected in the other endpoint. When a record that was previously synchronized is deleted in one endpoint, the Synchronizer recreates the record based on the data for the corresponding record in the other endpoint.

7 If your link contains additional requirement type mappings, repeat steps 1 to 6 to configure each mapping.

8 You can now define how data fields and field values are mapped between the endpoints. For more information, see “Creating Field Mappings” on page 54.

### Creating Field Mappings

After you define which changes to endpoint data are synchronized, you specify which fields are mapped and in which direction they are mapped. For example, you might map a field named **Priority** in one endpoint to a field named **Criticality** in the other endpoint.

Field mappings must be defined for each defects link, and for each requirement type mapping of a requirements link.

You can also map specific values for a field in one endpoint to specific values of a field in the other endpoint.

---

**Note:** The Synchronizer does not automatically refresh the list of endpoint fields displayed, as this may take some time. To display the current list of endpoint fields, in the **Field Mapping** tab, click **Refresh Schemas**. This refresh process also retrieves the current list of available endpoint filters displayed in the Filters tab.
This section includes the following topics:

➤ “Mapping Endpoint Fields” on page 55
➤ “Mapping Field Values” on page 64
➤ “Mapping Constant Values” on page 67
➤ “Mapping Attachment Fields” on page 68
➤ “Guidelines for Mapping Release and Cycle Fields” on page 69

**Mapping Endpoint Fields**

You map fields between the two endpoints in a synchronization link.

**To map endpoint fields for a link:**

1 Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2 Navigate to the Field Mapping tab.

   ➤ For a defects link, in the Links list, select the link and click the Field Mapping tab.

   ➤ For a requirements link, in the Links list, expand the link, select a requirement type mapping, and click the Field Mapping tab.

   Alternatively, from the Subtypes Mapping tab, under Mapped Subtypes, select a requirement type mapping and click Configure.
The field mapping configuration options are displayed.

The top part of the tab lists the fields for the entities being synchronized. Mapped entities are displayed in italics, as shown in the Headline field in this example.
The following columns are displayed for each field:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the field in the endpoint.</td>
</tr>
</tbody>
</table>
| **Type** | The field type. The following types are available:  
  - **Attachment**. The field contains attachments associated with the record. For more information on synchronizing record attachments, see “Mapping Attachment Fields” on page 68.  
  - **Date**. The field contains a date value.  
  - **Memo**. The field contains blocks of data.  
  - **Multi value list**. The field contains values from a predefined list. The field can contain more than one value from this list.  
  - **Number**. The field contains a numerical value.  
  - **Single value list**. The field contains a single value from a predefined list.  
  - **String**. The field contains string values.  
  - **User list**. The field contains a value from a list of users. |
| Attributes | Indicates whether the field is read-only. You cannot create a mapping to a field that is read-only. The following attribute values are available:  
  - **R**. The field can be read but cannot be written to.  
  - **RW**. The field can be both read and written to. |
| Mapped | Indicates whether the field is currently included in a mapping to a field in the other endpoint or a constant value is mapped to the field. |
In addition, an icon indicating whether the field is required is displayed adjacent to each field name in the Name column. The following table lists the possible options and details on how the level is determined for each field in Quality Center.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Mandatory</td>
<td>The field is mandatory for the endpoint. You must map this field as the destination of a mapping from a field in the other endpoint or map a constant value to the field. A mandatory field that is unmapped causes an error during an integrity check if entity creation is enabled for the endpoint. For a Quality Center endpoint, a field is Mandatory in the Synchronizer if it is a required field in Quality Center but not given a default value in Quality Center when a record is created.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Recommended</td>
<td>It is strongly recommended that you map this field as the destination of a mapping from a field in the other endpoint, but you are able to run synchronization tasks on the link if you do not create the mapping. A recommended field that is unmapped causes a warning during an integrity check if entity creation is enabled for the endpoint. For a Quality Center endpoint, a field is Recommended in the Synchronizer if it is required in Quality Center and is given a default value in Quality Center when a record is created.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Optional</td>
<td>You do not need to map this field as the destination of a mapping from a field in the other endpoint, but can optionally do so. For a Quality Center endpoint, a field is Optional in the Synchronizer if it is not required in Quality Center and is not given a default value in Quality Center when a new record is created.</td>
</tr>
</tbody>
</table>

To sort the fields by the data in a particular column, click the column header. Click the column header again to switch between sorting the data in ascending order and sorting the data in descending order.
4 You can filter the fields displayed in the fields list using the filter buttons located above the list of fields:

➤ To switch between showing and hiding Mandatory fields, click the Filter mandatory fields button.

➤ To switch between showing and hiding Recommended fields, click the Filter recommended fields button.

➤ To switch between showing and hiding Optional fields, click the Filter optional fields button.

5 To view the properties for a field, double-click a field, or select a field and click the View Field Properties button. The Field Properties dialog box opens listing the names, values, and descriptions of the field’s properties.

Select an item to view its description.

Note: Most of these fields can also be viewed in the Field Properties tab described in step 11 on page 63.
To import a set of field mappings from an exported XML link configuration file, click the **Import** button. In the Open dialog box, select the XML file from which you want to import the field mappings and click **Open**. The field mappings defined in the XML files are imported. For more information on exporting link configuration files, see “Exporting and Importing Link Definitions” on page 96.

You can also import field mappings from a sample file. Navigate to `<Quality Center Synchronizer Client directory>\samples` directory, and select the file for the type of endpoint that you are synchronizing with Quality Center.

To export a set of field mappings to an XML file, click the **Export** button. In the Save As dialog box, type a file name for the XML file to which you want to export the field mappings and click **Save**.

To add a mapping between fields in each endpoint, select the field in each endpoint that you want to map and click the **Map Selected Fields** down arrow. Choose the direction of the mapping using one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create bidirectional mapping</strong></td>
<td>Changes made to data in each endpoint are updated in the other endpoint. If you select this option, you must select which endpoint is the dominant endpoint. For more information on selecting the dominant endpoint, see step 10 on page 62.</td>
</tr>
</tbody>
</table>
| **Map <Quality Center Endpoint 1> field to <Destination Application> field** | Changes made to data in Quality Center are updated in the destination application during synchronization, but changes made to data in the destination application are not updated in Quality Center.  
**Note:** Changes to a record in the destination application may be overridden by changes to the corresponding record in Quality Center, even if the changes in the destination application were made after those in Quality Center. |
The mapping between the fields is added to the Mapped Fields list and the value of the Mapped column for the fields changes to Yes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Map <Source Application> field to <Quality Center Endpoint 1> field | Changes made to data in the source application are updated in Quality Center during synchronization, but changes made to data in Quality Center are not updated in the source application.  
**Note:** Changes to a record in Quality Center may be overridden by changes to the corresponding record in the source application, even if the changes in Quality Center were made after those in the source application. |

9 For fields of type **String**, **Single value list**, **Multi value list**, or **User list**, you can map specific field values between the endpoints. For more information, see “Mapping Field Values” on page 64.
To edit a field mapping’s properties, in the Mapped Fields list, select the mapping and click the **Mapping Properties** tab. Select the property you want to edit, click the down arrow, and select the new value. You can edit the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Direction</strong></td>
<td>The direction in which the synchronization can be performed. The options include:</td>
</tr>
<tr>
<td></td>
<td>➤ &lt;----&gt; <strong>Bidirectional</strong></td>
</tr>
<tr>
<td></td>
<td>➤ ----&gt; <strong>From Endpoint 1</strong> (Quality Center) <strong>to Endpoint 2</strong> (the synchronized application)</td>
</tr>
<tr>
<td></td>
<td>➤ &lt;---- <strong>From Endpoint 2</strong> (the synchronized application) <strong>to Endpoint 1</strong> (Quality Center)</td>
</tr>
<tr>
<td><strong>Dominant side</strong></td>
<td>Relevant for a bidirectional mapping. If changes are made to the same record in both endpoints since the last synchronization, the change made in the dominant endpoint is updated in the other endpoint. By default, Endpoint 1 (Quality Center) is the dominant endpoint. For example, suppose that since the last synchronization the value for a field in Endpoint 2 was changed to 20 and that the value for the corresponding field in Endpoint 1 was changed to 10. Suppose also that Endpoint 2 is the dominant endpoint. During the next synchronization, the Synchronizer will change the value of the field in Endpoint 1 to 20.</td>
</tr>
<tr>
<td><strong>Synchronize back on create</strong></td>
<td>Relevant for a single directional mapping. If, during synchronization, the destination endpoint creates a value that does not exist in the source endpoint, the new value is sent to source endpoint. This helps to ensure that both endpoints contain exactly the same data. For example, suppose that you created a new record in Quality Center. During synchronization, that record is added as a new record in the endpoint application, which subsequently generates an ID for the field. The Synchronizer recognizes this new value, sends it to Quality Center, and adds it to the source record.</td>
</tr>
</tbody>
</table>
To view details for the fields in a mapping, in the Mapped Fields list, select the mapping and click the **Field Properties** tab. The properties for the fields in the mapping are displayed.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>The field name used in the endpoint’s user interface.</td>
</tr>
<tr>
<td>Field Length</td>
<td>The length of the field in the endpoint.</td>
</tr>
<tr>
<td>Field Type</td>
<td>The field type in the endpoint.</td>
</tr>
<tr>
<td>Name</td>
<td>The field name used in the endpoint’s database.</td>
</tr>
<tr>
<td>Read only</td>
<td>Indicates if the field is a read-only field in the endpoint.</td>
</tr>
<tr>
<td>Required</td>
<td>The level assigned to the field.</td>
</tr>
<tr>
<td>Verified</td>
<td>Indicates whether the field’s values are validated in the endpoint against a fixed list.</td>
</tr>
</tbody>
</table>

To delete a field mapping, in the Mapped Fields list, select the mapping. In the toolbar above the Mapped Fields list, click the **Delete Field Mapping** button. Click **Yes** to confirm.

To check the field mappings you have defined, click the **Check Field Mapping** button. The Synchronizer runs a field mapping check. For information on the checks performed on the mappings, see “Checks Performed on Link Field Mappings” on page 23.

When the field mapping check has run, the Check Field Mapping report opens, displaying a list of errors that will cause the link to fail when run, warnings that may prevent the link running correctly, and other information. Close the report to continue.

**Note:** You must enable a link before you can run synchronization tasks on it. For more information on enabling links, see “Enabling and Disabling Synchronization Links” on page 93.
Chapter 3 • Creating Synchronization Links

Mapping Field Values

For a field of type String, Single value list, Multi value list, or User list, you can map specific values for a field in one endpoint to specific values of a field in the other endpoint.

For example, suppose a Quality Center field, Priority, has values Low, Medium, High, and Critical, and a field in the synchronized application, Importance, has values 1, 2, 3, and 4. You might map the values Low to 1, Medium to 2, High to 3, and Critical to 4. If the value of the Priority field in Quality Center changes from Medium to High, the Synchronizer updates the value of the corresponding field in the synchronized application from 2 to 3.

Note: If you map multiple values in one endpoint to a single value in the other endpoint, only one value can be synchronized back. This can potentially cause data loss. For example, suppose you map the following Priority values:

<table>
<thead>
<tr>
<th>Quality Center endpoint</th>
<th>Mapping Direction</th>
<th>Other application endpoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>&lt;---&gt;</td>
<td>High</td>
</tr>
<tr>
<td>Medium</td>
<td>&lt;---&gt;</td>
<td>Medium</td>
</tr>
<tr>
<td>Low</td>
<td>--&gt;</td>
<td>Medium</td>
</tr>
</tbody>
</table>

During a synchronization task, a Priority value of Low in Quality Center will be converted to Medium in the other endpoint. When that same record is synchronized back to Quality Center, the Priority value will be set to Medium, resulting in the loss of the original Low Priority value.
To map values for a field:

1. Select the link and verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2. In the Field Mapping tab, in the Mapped Fields list, select the field mapping for which you want to map field values. Click the Value Mapping tab. The Value mapping tab displays the field values currently mapped.

3. Click the Add Value Mapping button. The Add Value Mapping dialog box opens.

4. In the Endpoint 1 Value box, select or type the value from Endpoint 1 you want to include in the field value mapping.

5. In the Endpoint 2 Value box, select or type the value from Endpoint 2 you want to include in the field value mapping.
In the Direction box, select the direction for the field value mapping. The following options are available:

➤ <---->. Occurrences of the value in the Endpoint 1 Value box are mapped to the value in the Endpoint 2 Value box. Occurrences of the value in the Endpoint 2 Value box are mapped to the value in the Endpoint 1 Value box.

➤ ---->. Occurrences of the value in the Endpoint 1 Value box are mapped to the value in the Endpoint 2 Value box, but occurrences of the value in the Endpoint 2 Value box are not mapped to the value in the Endpoint 1 Value box.

➤ <----. Occurrences of the value in the Endpoint 2 Value box are mapped to the value in the Endpoint 1 Value box, but occurrences of the value in the Endpoint 1 Value box are not mapped to the value in the Endpoint 2 Value box.

Click OK.

---

**Note:** You can map one or more field values in the source endpoint to a single field value in the destination endpoint, but not vice versa.

---

To edit a mapping between field values, select the mapping and click the Edit Value Mapping button. In the Add Value Mapping dialog box, edit the mapping and click OK.

To remove a mapping between field values, select the mapping and click the Delete Value Mapping button.
Mapping Constant Values

Instead of mapping a field in one endpoint to a field in the other endpoint, you can assign a constant value to a field. This value is assigned to the field when the Synchronizer creates new entities. When the Synchronizer updates existing entities, the constant value is not assigned to the field, and the existing value is left unchanged.

Example 1: Suppose you have a required field in the Quality Center endpoint, but you do not have a field to map it to in the other endpoint. You can assign a constant value so that the required field is considered to be mapped, and the integrity check for this link can pass.

Example 2: Suppose you want to distinguish between defects created directly in Quality Center and those created in Quality Center by the Synchronizer. You could create a defects field named Creation Method in Quality Center and then assign this field the constant value Created by Quality Center Synchronizer.

Note: If you assign a constant value to a string field and the length of the constant value is longer than the maximum length of the string field, the Synchronizer truncates the constant value.

To map constant values:

1. Select the link and verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2. In the Field Mapping tab, in the fields list for the appropriate endpoint, select the field to which you want to map a constant value.
Chapter 3 • Creating Synchronization Links

3 Click the **Add Constant Value** button (located above the endpoint schema grid). The Add Constant Value dialog box opens.

![Add Constant Value dialog box](image)

4 Type or select the constant value you want to be assigned to the field during record creation.

5 Click **OK** to close the Add Constant Value dialog box.

**Mapping Attachment Fields**

In addition to mapping regular fields between the two endpoints, you can also map attachment fields between the endpoints. When you synchronize an attachment field, both the attachment and its description are synchronized.

Consider the following guidelines when mapping attachment fields:

- You can create only one mapping between attachment fields per link.
- The Synchronizer identifies attachments by their file name, and not by their content. Therefore:
  - If you change the file name of an attachment, even if you do not change its content, the Synchronizer determines that the original attachment has been deleted and a new attachment added, and synchronizes the attachment fields accordingly.
  - If you have different attachments in each of the endpoints, but they have the same file name, the Synchronizer is not able to distinguish between them and considers them as the same attachment.
Chapter 3 • Creating Synchronization Links

➤ For a bidirectional attachment field mapping, if an attachment was updated in both endpoints since the last synchronization, the Synchronizer copies the attachment in the non-dominant endpoint to the conflict_backup directory, located under the main Quality Center Synchronizer directory. It then overwrites the attachment in the non-dominant endpoint with the attachment in the dominant endpoint.

Guidelines for Mapping Release and Cycle Fields

Consider the following guidelines when mapping release and cycle fields:

➤ The following Quality Center release and cycle fields are available for mapping:
  ➤ For requirements synchronization: Target Release.
  ➤ For defects synchronization: Target Release, Target Cycle, Detected in Release, Detected in Cycle.

➤ To map a cycle field, you must also map the corresponding release field. For example, if you map the Target Cycle field, you must also map the Target Release field.

➤ Release names must be unique in both endpoints. Unique release names enable the Synchronizer to identify releases and cycles. In addition, because other endpoints may not have a hierarchical release and cycle structure, duplicate Quality Center release names are problematic. If you map release fields, and release names are not unique within an endpoint, an error is written to the log file during a synchronization task run, and the records are not synchronized.

The following example illustrates the use of unique release names in Quality Center. Suppose you have two release folders in the Quality Center Releases module named Cruise Application and Flight Application. You can name releases within the folders in the following way:
Chapter 3 • Creating Synchronization Links

➤ If release names are not unique within an endpoint, you can map specific field values to define the full path of the release. For example, you can map each value of the Target Release field to a value in a corresponding field in the other endpoint. You define the full path of the Quality Center release in the format `<Release_Folder_Name>`\ `<Release_Name>`. For example, `Flight Application\Release_2`. You do not need to include the root Releases folder in the path.

For more information on mapping field values, see “Mapping Field Values” on page 64, or “Mapping Constant Values” on page 67.

Setting Mail Notifications

You can instruct the Synchronizer to send email notifications for:

➤ Failed link task runs
➤ Passed link task runs with errors

To set mail notifications:

1 Verify that you are working in edit mode. For more information, see “Editing Synchronization Link Settings” on page 90.

2 Select Tools > Server Options and specify the email settings. For more information, see “Configuring the Server Options” on page 100.

3 Click the Advanced tab.
4 Set the email notification settings:

➤ In the Email address box, type an email address to instruct the Synchronizer server to send email notifications for failed link task runs (and also for task runs that pass with errors if you select the check box below). Only one email address can be specified for each link. The email notifications are sent according to the email settings defined for the Synchronizer server.

➤ Select the **Send notification when task passes with errors** check box to instruct the Synchronizer to send an email notification to the email address listed above when a synchronization task passes with errors.

### Setting Adapter Parameters

By default, the Synchronizer supports specific connectivity parameters for each adapter type. An **adapter** is the endpoint application to which the Synchronizer connects. You can view these connectivity parameters, and the values defined for them, in the Connectivity tab.

If an adapter requires additional parameters, for example, because the adapter was modified, or you are working with an adapter other than the defaults supported by the Synchronizer, these additional parameters are displayed in the Advanced tab.

For more information on specific parameters, refer to the appropriate appendix for the endpoint.

**To define the value for an adapter parameter:**

Click the **Value** cell for the adapter parameter you want to define and enter the parameter value.
This chapter describes how to work with the Synchronizer. You can run an integrity check to verify configuration settings for a synchronization link. You can also run, configure, enable, disable, and delete synchronization links, and change your Quality Center Synchronizer password.

This chapter includes:

- Viewing Link Details on page 74
- Running Link Tasks on page 80
- Viewing Task Run History on page 84
- Viewing Task Run Reports on page 86
- Editing Synchronization Link Settings on page 90
- Resetting a Link on page 91
- Enabling and Disabling Synchronization Links on page 93
- Deleting Synchronization Links on page 94
- Automatic Backup of the Quality Center Synchronizer Database on page 95
- Restoring the Quality Center Synchronizer Database on page 95
- Exporting and Importing Link Definitions on page 96
- Exporting and Importing Link Data on page 97
- Configuring the Quality Center Synchronizer Options on page 99
- Changing the Quality Center Synchronizer Password on page 102
Viewing Link Details

You can view details for all your synchronization links in a grid. You can also view details for a specific link.

This section contains the following topics:

➤ “Viewing Details for All Links” on page 74
➤ “Viewing Details for a Specific Link” on page 76
➤ “The Link Fields” on page 77

Viewing Details for All Links

You can view details for all your synchronization links in the Links Grid.

To view details for all links:

1. In the Links list, select the root folder Links. The Links Grid is displayed.

Each row in the Links Grid displays details for a synchronization link. For more information on the fields displayed in the grid, see “The Link Fields” on page 77.
2 To sort the Links Grid by the data in a particular column, click the column header. Click the column header again to switch between sorting the data in ascending order and sorting the data in descending order.

3 To refresh a selected record in the Links Grid, select Link > Refresh, or click the Refresh Selected button, or click the down arrow and select Refresh Selected. This can be useful as changes to link status that occur due to events in the Synchronizer server, such as an integration check passing successfully, are not automatically updated in the Synchronizer client.

4 To refresh the information in all of the rows in the Links Grid, click the Refresh Selected down arrow and select Refresh All.
**Viewing Details for a Specific Link**

You can view details for a specific link.

**To view details for a specific link:**

1. In the Links list, select a link for which you want to view details. The link’s details are displayed in the General tab.

   ![Screenshot of the General tab with a link selected](image)

   For more information on the fields displayed in the General tab, see “The Link Fields” on page 77.

   To view requirement type mappings for a requirements link, expand the link. For more information on mappings between requirement types, see “Creating Requirement Type Mappings” on page 47.

2. To refresh the information displayed in the General tab, click the **Refresh Selected** button or click the down arrow and select **Refresh Selected**. This can be useful as changes to link status that occur due to events in the Synchronizer server, such as an integration check passing successfully, are not automatically updated in the Synchronizer client.
You can view history details of the task runs for the link. For more information, see “Viewing Task Run History” on page 84.

The Link Fields

The following details are displayed in the Links Grid and the General tab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoMode</td>
<td>Indicates whether the synchronization link is in automatic mode:</td>
</tr>
<tr>
<td></td>
<td>➤ If the field has value <strong>True</strong>, the link is in automatic mode and will run automatically at time intervals you specified in the Scheduling tab.</td>
</tr>
<tr>
<td></td>
<td>➤ If the field has value <strong>False</strong>, the link will run only if you manually instruct it to do so. For more information on running links, see “Running Link Tasks” on page 80.</td>
</tr>
<tr>
<td>Endpoint 1</td>
<td>The type of endpoint for Endpoint 1 and the type of entity being synchronized in the endpoint. Possible values are <strong>QualityCenter:Requirement</strong> and <strong>QualityCenter:Defect</strong>.</td>
</tr>
<tr>
<td>Endpoint 1 Connectivity Data</td>
<td>Settings for the connection to Endpoint 1. Includes the Quality Center server, domain, and project with which the Synchronizer is synchronizing.</td>
</tr>
<tr>
<td>Endpoint 1 Entity Name</td>
<td>The type of entity being synchronized in Endpoint 1. Possible values are <strong>Requirement</strong> and <strong>Defect</strong>.</td>
</tr>
<tr>
<td>Endpoint 1 Name</td>
<td>The name assigned to the endpoint. By default, this is the endpoint type. For more information on editing the endpoint name, see “Setting Link Properties” on page 38.</td>
</tr>
<tr>
<td>Endpoint 1 Type</td>
<td>The type of endpoint for Endpoint 1, which must always be <strong>Quality Center</strong>.</td>
</tr>
<tr>
<td>Endpoint 2</td>
<td>The type of endpoint for Endpoint 2 and the type of entity being synchronized in the endpoint.</td>
</tr>
</tbody>
</table>
## Working with Quality Center Synchronizer

### Endpoint 2 Connectivity Data
Settings for the connection to Endpoint 2. The information displayed is dependent on the type of endpoint used. For more details on the settings available for a particular endpoint, refer to the appropriate appendix for that endpoint.

### Endpoint 2 Entity Name
The type of entity being synchronized in Endpoint 2. Possible values are **Requirement** and **Defect**.

### Endpoint 2 Name
The name assigned to the endpoint. By default, this is the endpoint type. For more information on editing the endpoint name, see “Setting Link Properties” on page 38.

### Endpoint 2 Type
The type of endpoint for Endpoint 2.

### ID
A unique identification number assigned by the Synchronizer to the link. This number cannot be modified.

### Last Full Synchronization
The result of the last full synchronization run on the link and the date and time it was run. For more information on running full synchronizations, see “Running Link Tasks” on page 80.

### Last Incremental Synchronization
The result of the last incremental synchronization run on the link and the date and time it was run. For more information on running incremental synchronizations, see “Running Link Tasks” on page 80.

### Last Integrity Check
The result of the last integrity check run on the link and the date and time it was run. For more information on running integrity checks, see “Running Link Tasks” on page 80.

### Link Description
A description of the link.

### Link Name
The name of the link.

### Link State
Indicates whether the link is enabled, disabled, or unvalidated. For more information about these states, see “Enabling and Disabling Synchronization Links” on page 93.

### Mapped Records
The number of records mapped for synchronization.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint 2 Connectivity Data</td>
<td>Settings for the connection to Endpoint 2. The information displayed is dependent on the type of endpoint used. For more details on the</td>
</tr>
<tr>
<td></td>
<td>settings available for a particular endpoint, refer to the appropriate appendix for that endpoint.</td>
</tr>
<tr>
<td>Endpoint 2 Entity Name</td>
<td>The type of entity being synchronized in Endpoint 2. Possible values are <strong>Requirement</strong> and <strong>Defect</strong>.</td>
</tr>
<tr>
<td>Endpoint 2 Name</td>
<td>The name assigned to the endpoint. By default, this is the endpoint type. For more information on editing the endpoint name, see “Setting</td>
</tr>
<tr>
<td></td>
<td>Link Properties” on page 38.</td>
</tr>
<tr>
<td>Endpoint 2 Type</td>
<td>The type of endpoint for Endpoint 2.</td>
</tr>
<tr>
<td>ID</td>
<td>A unique identification number assigned by the Synchronizer to the link. This number cannot be modified.</td>
</tr>
<tr>
<td>Last Full Synchronization</td>
<td>The result of the last full synchronization run on the link and the date and time it was run. For more information on running full</td>
</tr>
<tr>
<td></td>
<td>synchronizations, see “Running Link Tasks” on page 80.</td>
</tr>
<tr>
<td>Last Incremental Synchronization</td>
<td>The result of the last incremental synchronization run on the link and the date and time it was run. For more information on running</td>
</tr>
<tr>
<td></td>
<td>incremental synchronizations, see “Running Link Tasks” on page 80.</td>
</tr>
<tr>
<td>Last Integrity Check</td>
<td>The result of the last integrity check run on the link and the date and time it was run. For more information on running integrity</td>
</tr>
<tr>
<td></td>
<td>checks, see “Running Link Tasks” on page 80.</td>
</tr>
<tr>
<td>Link Description</td>
<td>A description of the link.</td>
</tr>
<tr>
<td>Link Name</td>
<td>The name of the link.</td>
</tr>
<tr>
<td>Link State</td>
<td>Indicates whether the link is enabled, disabled, or unvalidated. For more information about these states, see “Enabling and Disabling</td>
</tr>
<tr>
<td></td>
<td>Synchronization Links” on page 93.</td>
</tr>
<tr>
<td>Mapped Records</td>
<td>The number of records mapped for synchronization.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run ID</td>
<td>A unique identification number of the current task run for the link.</td>
</tr>
<tr>
<td>Running</td>
<td>Indicates whether a task for the link is currently running:</td>
</tr>
<tr>
<td></td>
<td>➤ If the field has value <strong>True</strong>, the link is in the middle of a task execution, such as an integrity check, incremental synchronization, or full synchronization. You cannot perform another operation on the link until the first operation has finished running.</td>
</tr>
<tr>
<td></td>
<td>➤ If the field has value <strong>False</strong>, no tasks for the link are currently running, and you can perform an operation on the link, provided it is enabled.</td>
</tr>
<tr>
<td>State</td>
<td>Indicates whether the link is enabled, disabled, or unvalidated. For more information about these states, see “Enabling and Disabling Synchronization Links” on page 93.</td>
</tr>
<tr>
<td>Time Stamp</td>
<td>Indicates the time when the last synchronization on the link was started. This time is used by the Synchronizer to determine which records were created or updated since the last synchronization. To manually change this time stamp, see “Resetting a Link” on page 91.</td>
</tr>
</tbody>
</table>
Chapter 4 • Working with Quality Center Synchronizer

Running Link Tasks

You can run incremental synchronization tasks and full synchronization tasks in automatic mode, so that the task is run automatically at specified time intervals. Alternatively, you can run a link task manually. For more information on link tasks, see “Incremental Synchronizations” on page 25 and “Full Synchronizations” on page 26.

Important Note: When you run a synchronization task, any locked record in an endpoint is not synchronized. You can check the report at the end of a synchronization task run to determine if any records were not synchronized, and why they were not synchronized. If a mapped record was not synchronized because it was locked during the run, you can update it by:

➤ Running an incremental synchronization task after the record is modified again. For information on incremental synchronization tasks, see “Incremental Synchronizations” on page 25.
➤ Resetting the time stamp. For more information, see “Resetting a Link” on page 91.
➤ Running a full synchronization task. For information on full synchronization tasks, see “Full Synchronizations” on page 26.

This section contains the following topics:

➤ “Running Link Tasks in Automatic Mode” on page 80
➤ “Running Link Tasks Manually” on page 82

Running Link Tasks in Automatic Mode

You can run incremental synchronization tasks and full synchronization tasks in automatic mode. The task is run at time intervals you specify in the Scheduling tab. This is useful when there are regular changes to the data you want to synchronize.
The Synchronizer can run only one task at a time for a particular synchronization link. The Synchronizer resolves possible conflicts between tasks using the following rules:

➤ If a task is already running for a link and the scheduled time for a second task of a different type arrives, the second task waits in a queue and runs immediately upon completion of the first task. If the second task is of the same type, for example if they are both incremental synchronization tasks, the second task does not run at all.

➤ If both an incremental synchronization task and a full synchronization task for the same link are scheduled for the same time, the full synchronization task runs before the incremental synchronization task. The incremental synchronization task enters a queue and runs upon completion of the full synchronization task.

The Synchronizer can run one full synchronization task or five incremental synchronization tasks from different links simultaneously. If the scheduled time for an additional task arrives when the maximum number of tasks is already running, the additional task waits in a queue. When a task that is currently running completes, the additional task runs.

To run a link task in automatic mode:

1 Ensure that the link has passed an integrity check. For information on integrity checks, see “Integrity Checks” on page 20. For information on running an integrity check, see “Running Link Tasks Manually” on page 82.

2 Ensure that the task is set to run in automatic mode in the Scheduling tab. For more information on editing configuration settings for a link, see “Editing Synchronization Link Settings” on page 90. For more information on available settings for running tasks automatically, see “Setting Scheduling Options” on page 42.

3 Ensure that the link is enabled. For more information on enabling links, see “Enabling and Disabling Synchronization Links” on page 93.

4 If a task is currently running for a link, a green arrow is added to the link’s icon in the Links list. To verify that the information displayed is current, click the Refresh Selected button or click the down arrow and select Refresh Selected.
To monitor the progress of a task that is currently running, in the Links list, right-click the link on which the task is running and click **View Run**. The task's progress is displayed in the Execution pane. For more information on viewing and managing a task's progress in the Execution pane, see “Running Link Tasks Manually” on page 82.

**Running Link Tasks Manually**

You can run a link task manually.

---

**Note:** The maximum number of concurrent tasks that can run manually or in automatic mode are as follows:

- Only one task can run at a time for a particular synchronization link.
- One full synchronization task or five incremental synchronization tasks from different links can run concurrently.

If the maximum number of tasks are already running, the link task does not run.

---

**To run a link task manually:**

1. Ensure that the link is enabled. For more information on enabling links, see “Enabling and Disabling Synchronization Links” on page 93.

2. In the Links list or Links Grid, perform one of the following actions:

   - To run an integrity check task, select the link on which you want to run the task. Choose **Run Task > Run Integrity Check** or click the **Run** button and choose **Integrity Check**.
   
   - To run an incremental synchronization task, select the link on which you want to run the task. Choose **Run Task > Run Incremental Synchronization** or click the **Run** button and choose **Incremental Synchronization**.
   
   - To run a full synchronization task, select the link on which you want to run the task. Choose **Run Task > Run Full Synchronization** or click the **Run** button and choose **Full Synchronization**.
The task starts running in the Execution pane.

3 If the Auto Refresh check box is selected, the client periodically samples the information messages generated by the server as the task progresses and displays them in the Execution pane. To prevent the automatic display of these information messages, clear the Auto Refresh check box.

4 If the Auto Refresh check box is not selected, you can click the Refresh Progress button at any stage during the execution of the task to display the next information message on the task’s progress.

5 At any stage during the execution of the task, you can click the Cancel Current Task button to cancel the execution of the task.

6 When the task has finished running, you can click the View Report button to view a report summarizing the task run. For more information on viewing reports, see “Viewing Task Run Reports” on page 86.
Chapter 4 • Working with Quality Center Synchronizer

Viewing Task Run History

You can view the history of the tasks run for a link. For each task run, you can view a report detailing the progress of the task.

To view task run history:

1. In the Links list, select a link.

2. In the General tab, under State Details, click the Get History button for the type of task for which you want to view run history. The Run History dialog box opens.

<table>
<thead>
<tr>
<th>Run ID</th>
<th>State</th>
<th>Start Time</th>
<th>End Time</th>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Passed</td>
<td>05/15/2008 14:29:39</td>
<td>05/15/2008 14:30:09</td>
<td>View Report</td>
</tr>
<tr>
<td>1</td>
<td>Failed</td>
<td>05/15/2008 14:18:29</td>
<td>05/15/2008 14:17:18</td>
<td>View Report</td>
</tr>
</tbody>
</table>
The task run details for the link are displayed in a grid, which contains the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run ID</td>
<td>A unique identification number for the task run, assigned by the Synchronizer.</td>
</tr>
<tr>
<td>State</td>
<td>The final status of the task run. Possible statuses:</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Passed</strong>. Either all records synchronized successfully, or there were no changed records to be synchronized.</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Failed</strong>. No records synchronized successfully.</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Passed with errors</strong>. At least one record synchronized successfully. (Not relevant for integrity check task runs.)</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Error</strong>. System error occurred preventing synchronization.</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Cancelled</strong>. User cancelled synchronization task.</td>
</tr>
<tr>
<td>Start Time</td>
<td>The date and time at which the task started running.</td>
</tr>
<tr>
<td>End Time</td>
<td>The date and time at which the task finished running.</td>
</tr>
<tr>
<td>Report</td>
<td>Enables you to view a report for the task run.</td>
</tr>
</tbody>
</table>

3. To view a report for a task run, click the **View Report** button for the task run. For more information on viewing task run reports, see “Viewing Task Run Reports” on page 86.

4. To sort the grid by the data in a particular column, click the column header. Click the column header again to switch between sorting the data in ascending order and sorting the data in descending order.

5. Click **Close** to close the Run History dialog box.
Viewing Task Run Reports

You can view a report from a task run for a synchronization link.

To view a task run report:

1. Open the task report using one of the following methods:
   - You can view a report for a task run in the Execution pane. For more information, see “Running Link Tasks” on page 80.
   - You can also view a report for a previous task run. For more information, see “Viewing Task Run History” on page 84.

The task report opens.
The report contains the following details:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report For Link</td>
<td>The name of the synchronization link for which the task ran.</td>
</tr>
<tr>
<td>Status</td>
<td>The final status of the task run. Possible statuses:</td>
</tr>
<tr>
<td></td>
<td>➤ Passed. Either all records synchronized successfully, or there were no</td>
</tr>
<tr>
<td></td>
<td>changed records to be synchronized.</td>
</tr>
<tr>
<td></td>
<td>➤ Failed. No records synchronized successfully.</td>
</tr>
<tr>
<td></td>
<td>➤ Passed with errors. At least one record synchronized successfully. (Not</td>
</tr>
<tr>
<td></td>
<td>relevant for integrity check task runs.)</td>
</tr>
<tr>
<td></td>
<td>➤ Error. System error occurred preventing synchronization.</td>
</tr>
<tr>
<td></td>
<td>➤ Cancelled. User cancelled synchronization task.</td>
</tr>
<tr>
<td>Run ID</td>
<td>A unique identification number for the task run, assigned by the</td>
</tr>
<tr>
<td></td>
<td>Synchronizer.</td>
</tr>
<tr>
<td>Run Type</td>
<td>The type of link task.</td>
</tr>
<tr>
<td>Run Start Time</td>
<td>The time the execution of the task started.</td>
</tr>
<tr>
<td>Run End Time</td>
<td>The time the execution of the task finished.</td>
</tr>
<tr>
<td>Summary</td>
<td>A summary of the following task run information, dependent on the type of</td>
</tr>
<tr>
<td></td>
<td>task run:</td>
</tr>
<tr>
<td></td>
<td>➤ Integrity check. The number of checks passed, passed with warning and</td>
</tr>
<tr>
<td></td>
<td>failed.</td>
</tr>
<tr>
<td></td>
<td>➤ Incremental synchronization and full synchronization. A list of the number</td>
</tr>
<tr>
<td></td>
<td>of records created, updated, and deleted in each endpoint and the number</td>
</tr>
<tr>
<td></td>
<td>of records that the Synchronizer failed to synchronize.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Basic connection information about the two endpoints in the link.</td>
</tr>
</tbody>
</table>
Chapter 4 • Working with Quality Center Synchronizer

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General checks</strong></td>
<td>Lists the general checks performed on each endpoint. For a list of the general checks performed during an integrity check, see “Checks Performed on General Link Settings” on page 21.</td>
</tr>
<tr>
<td>(integrity check task only)</td>
<td></td>
</tr>
<tr>
<td><strong>Field mapping checks</strong></td>
<td>Lists the field mapping checks performed on each endpoint. For a list of the field mapping checks performed during an integrity check, see “Checks Performed on Link Field Mappings” on page 23.</td>
</tr>
<tr>
<td>(integrity check task only)</td>
<td></td>
</tr>
</tbody>
</table>
To view a log file displaying events processed by the Synchronizer server during the execution of the task, click the **View Log** link in the bottom left corner of the report. The log file for the task run opens. The log file can be useful when tracing errors and problems that occurred during the execution of the task. For each message, the Synchronizer displays the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>The time at which the message was generated.</td>
</tr>
</tbody>
</table>
| Level  | The level of severity of the message. Can have one of the following values:  
  - **ERROR**: A warning of a critical problem with the link.  
    - If an error occurs during an integrity check, the integrity check fails and you cannot run tasks on the link.  
    - If an error occurs during a synchronization task, it may indicate a general problem with the link, in which case the synchronization tasks fails. Alternatively, it may indicate a problem with synchronizing a particular record, in which case the synchronization passes with errors.  
  - **WARN**: A warning of an issue of which you should be aware.  
    - If a warning occurs during an integrity check, the integrity check does not fail, so tasks on the link can run, but it may cause unexpected results.  
    - If a warning occurs during a synchronization task, it may indicate that the synchronization had unexpected or undesired results.  
  - **INFO**: A message displayed for information only. No action is necessary. |
| Category | The category of the message. |
| Message | The text of the message. |
Editing Synchronization Link Settings

You can edit the settings for a synchronization link.

**Note:** When you edit the settings for a synchronization link, the link’s state is changed to **Unvalidated**. You must enable the link before you can run synchronization tasks on it. For more information on enabling links, see “Enabling and Disabling Synchronization Links” on page 93.

**To edit synchronization link settings:**

1. In the Links list, select the link and click the **Edit** button. The link details are made available for editing.

   **Note:** When editing link settings, you must save the new settings before you can enable the link. For more information on enabling links, see “Enabling and Disabling Synchronization Links” on page 93.

2. Edit the configuration settings. A red asterisk next to the link’s icon in the Links list indicates unsaved changes in that link.

   **Note:** You can edit more than one link simultaneously.

For more information on configuration settings, see Chapter 3, “Creating Synchronization Links.”

3. To undo all changes, click the **Discard Changes** button.

4. To save the new configuration settings, click the **Save** button. Click **Yes** to confirm. To run the integrity check, click **Yes**.
Resetting a Link

Each synchronization link in the Synchronizer has an associated time stamp, and each record mapping within a link has a version. The time stamp represents the time the link was last handled by the Synchronizer. The version enables the Synchronizer to identify the records that can be synchronized.

When the Synchronizer runs a synchronization task for a link, it updates the time stamp for the link at the start of the task’s execution. In addition, when the Synchronizer handles the successful synchronization of a paired record mapping, it adds a record containing the versions of each pair of synchronized records to the database.

The Synchronizer uses the time stamp and versions when it determines which records to synchronize. In some circumstances, you may want to override the automatic time stamp and the record version history:

➤ **Time stamp.** You can override the automatic time stamp and reset the time stamp to a time prior to the last synchronization. This is useful if there were issues with the latest synchronization of some records, and you want to revert to an earlier version of these records so that you can run a synchronization task again.

➤ **Synchronization history.** You can perform a complete reset to clear both the time stamp and the version history for the mapped records. This is useful when a field mapping changes, and you want to synchronize the mapped entities as if you created a new link.

Consider carefully the consequences before deciding to reset the time stamp for a link, and which option to use when resetting it.

---

**Tip:** You can sometimes achieve the same outcome as resetting the link’s time stamp by running a full synchronization task. For more information on full synchronization tasks, see “Full Synchronizations” on page 26.
To reset the time stamp for a link or the entire link:

1. In the Links list or Links Grid, select the link and choose **Link > Reset** or click the **Reset Link** button. The Reset Link dialog box opens.

![Reset Link dialog box](image)

2. Select one of the following options to reset the link:
   - **Reset to specific time stamp.** The time stamp for the link resets to a time you specify. To specify a date, you can click the down arrow and select from the calendar. You can also manually edit the time and date in the **Reset to specific time stamp** box.
   - **Complete link reset.** Clears all synchronization version history for mapped records in addition to completely resetting the time stamp for this link. Select this option to clear all synchronization history.

3. Click **OK** to close the Reset Link dialog box. The time stamp is reset in the **Time Stamp** field of the Links Grid and General tab.
Enabling and Disabling Synchronization Links

Each synchronization link can be in one of the following states: Unvalidated, Disabled, and Enabled. The following table lists these states and their descriptions. It also lists under what circumstances the link moves between states.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
<th>When State Entered</th>
<th>When State Left</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unvalidated</td>
<td>The link's configuration has not been verified. You cannot run tasks for the link.</td>
<td>Upon creation of a new link or modification of the configuration of an existing link.</td>
<td>Upon execution of an integrity check. For more information on running integrity checks, see “Running Link Tasks Manually” on page 82.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The link's configuration has been verified, but you cannot run tasks on the link.</td>
<td>Upon successful completion of an integrity check, or manually from status Enabled.</td>
<td>Manually to status Enabled, or after modification of link configuration to status Unvalidated.</td>
</tr>
<tr>
<td>Enabled</td>
<td>The link's configuration has been validated, and you can run tasks on the link.</td>
<td>Manually from status Disabled.</td>
<td>Manually to status Disabled, or after modification of link configuration to status Unvalidated.</td>
</tr>
</tbody>
</table>

To enable a synchronization link:

1. In the Links list or Links Grid, select the link you want to enable.

2. Make sure that the link is in the state Disabled. If the link is in the state Unvalidated, you must run an integrity check to change its state to Disabled. For more information on running integrity checks, see “Running Link Tasks Manually” on page 82.

3. Click the Enable Link button or choose Link > Enable.
To disable a synchronization link:

1. In the Links list or Links Grid, select the link you want to disable.

2. Click the **Disable Link** button or choose **Link > Disable**.

**Deleting Synchronization Links**

You can delete a link from the Synchronizer database.

---

**Important**: Consider carefully before you delete a synchronization link, as deleting links can have unintended consequences. If you create and run a synchronization link, run an updated record synchronization, delete the link, and create the same link again, the next updated record synchronization you perform duplicates the records in both endpoints.

For example, suppose you synchronized your records so that defects Bug 1 and Bug 2 exist in both your Quality Center project and your other endpoint. After deleting the synchronization link, creating the same link again, and performing another record synchronization, Bug 1 and Bug 2 will each appear twice in both Quality Center and the other endpoint.

---

To delete a synchronization link:

1. In the Links list or Links Grid, select the link you want to delete and choose **Link > Delete**.

2. Click **Yes** to confirm.
Automatic Backup of the Quality Center Synchronizer Database

The Synchronizer database is backed up automatically every eight hours. Three previous backup files are maintained and then overwritten as new backups are created.

The backup file is named qcsync_db.backup and is located by default in the <Quality Center Synchronizer installation directory>\backup directory on the Synchronizer server. It is recommended that you back up this directory regularly, or change the default backup location to a network drive that is regularly backed up, in order to ease data restoration in the event of local hard disk failure.

For information on changing the default backup location, see “Configuring the Server Options” on page 100.

Restoring the Quality Center Synchronizer Database

You can restore the Quality Center Synchronizer database from an automatic backup file. For more information on automatic database backup, see “Automatic Backup of the Quality Center Synchronizer Database” above.

To restore the Synchronizer database from a backup file:

1. Open the Windows command prompt by clicking Start > Run and typing cmd. Click OK.

2. Navigate to the <Quality Center Synchronizer installation directory>\bin directory, and run the following command line:
   ```bash
   restore_data.bat <backup filename>
   ```
   where <backup filename> is the backup file you want to restore. By default, the Synchronizer backup files are located in the <Quality Center Synchronizer installation directory>\backup directory on the Synchronizer server.
Exporting and Importing Link Definitions

You can export the definition of a synchronization link to an XML file. This enables you to reuse configuration settings for existing links when creating new links. Exporting the link definition does not export the identity mapping data for the link. If you want to also export the identity mapping data, you can export the link data. For more information, see “Exporting and Importing Link Data” on page 97.

You can also export and import only the field mappings from a synchronization link definition. For more information, see “Creating Field Mappings” on page 54.

This section includes the following topics:

➤ “Exporting Link Definitions” on page 96
➤ “Importing Link Definitions” on page 97

Exporting Link Definitions

You can export the definition of a synchronization link to an XML file.

To export a link definition:

1 Select Link > Export > Link Configuration Into XML File. The Save As dialog box opens.

2 In the Open dialog box, in the File name box, type the name of the XML file to which you want to export the link configuration data.

3 Click Save. The link configuration data is exported to the XML file you specified.
Chapter 4 • Working with Quality Center Synchronizer

Importing Link Definitions

You can import the definition of a synchronization link that has been saved as an XML file.

To import a link definition:

1 Select Link > Create From > Link Configuration XML File. The Open dialog box opens.
2 In the Open dialog box, select the XML file that defines the link you want to import.
3 Click Open. A new link is created in the Links Grid based on the settings defined in the XML file.

Exporting and Importing Link Data

You can export the data for a synchronization link to a .zip file. Both the link configuration data and the record identity mapping data are exported as separate files within the .zip file. This enables you to backup link configuration data and identity mappings.

Tip: To move the Quality Center Synchronizer to a different machine, you can export link data, install the Synchronizer on the new machine, and then import the link data to the new machine.

This section includes the following topics:

➤ “Exporting Link Data” on page 98
➤ “Importing Link Data” on page 98
Chapter 4 • Working with Quality Center Synchronizer

Exporting Link Data
You can export link data to a .zip file. The file is named `<link name>.zip` and is located by default in the `<Quality Center Synchronizer installation directory>\backup` directory on the Synchronizer server. For information on changing this location, see “Configuring the Server Options” on page 100.

**Note:** The name of the exported file is not editable and is based on the name of the link. If you have already backed up data for the link or a link with the same name, exporting link data will overwrite the existing backup file.

To export link data:
Select **Link > Export > Link Data Into Backup File**. The link’s configuration data and record identity mapping data are exported.

Importing Link Data
You can import previously exported link configuration data and record identity mapping data.

To import link data:
1 Select **Link > Create From > Link Backup File**. The Create From Link Backup File dialog box opens.
2 In the File name box, select the name of the backup file containing the data you want to import. Link backup files are located in the backup directory on the Synchronizer server. By default, this directory is `<Quality Center Synchronizer installation directory>\backup`. For information on changing this directory, see “Configuring the Server Options” on page 100.

3 Click the Submit button. A new link is created in the Links Grid based on the settings defined in the XML file included in the .zip file. This link also includes the imported identity mapping data.

**Configuring the Quality Center Synchronizer Options**

You can configure the Synchronizer client and server options. This section includes the following topics:

- “Configuring the Client Options” on page 99
- “Configuring the Server Options” on page 100

**Configuring the Client Options**

You can configure the options for a local Synchronizer client.

To configure the client options:

1 Choose Tools > Local Client Options. The Local Client Options dialog box opens.

2 In the Number of runs to display box, type the number of runs you want to display when viewing the task run history for a synchronization link.

3 Click OK.
Configuring the Server Options

You can configure the Synchronizer server options. If you enter email settings, you can specify the email address in the Advanced tab. For more information, see “Setting Mail Notifications” on page 70.

To configure the server options:


2. Under Run History, specify the number of days for which you want to keep the history of tasks run for a synchronization link.

3. Under Email Settings, specify the details of the SMTP mail server you want to use for sending notifications of link task run failures. The following settings are available:
   - SMTP Server. The SMTP server host name.
   - User name. The user name used to connect to the mail server.
Chapter 4 • Working with Quality Center Synchronizer

➤ **Password.** The password for the user specified to connect to the mail server.

➤ Click the **Test** button to try sending a test email to an email address. The Test Mail dialog box opens. Enter a valid address and click **Send**.

---

**Note:** You can determine for each link individually whether to send mail notifications in the case of task run failure. For more information, see “Setting Mail Notifications” on page 70.

---

4 Under **Server Backup Location,** type the location on the server machine to which you want to save backup data.

---

**Note:** If you choose to save backup data to a network drive not on the server machine, the user configured to log on as a service must have permissions to write to the specified location. For more information, refer to the *Quality Center Synchronizer Installation Guide.*

---

The backup location you specify applies to files created during automatic backup of the Synchronizer database and files created when you export link data manually. For more information on automatic backup of the Synchronizer database, see “Automatic Backup of the Quality Center Synchronizer Database” on page 95. For more information on exporting link data, see “Exporting Link Data” on page 98.

5 Under **Log Settings,** select **Enable advanced logging** to instruct the Synchronizer to store extended log information for each link task run. These log files are not generated by default and can use a significant amount of disk space.

By default, the Synchronizer stores details of a task run in a log file that you view from the **Task Run Report.** For more information on the default log, see “Viewing Task Run Reports” on page 86.
Chapter 4 • Working with Quality Center Synchronizer

If this option is selected, the Synchronizer generates an additional log file for each link task that is run. The log files are located in the `<Quality Center Synchronizer installation directory>\log` directory, and named with the following format: `run_<Run ID>_link_<Link ID>.log`. For information on locating the Run ID for a task run, see “Viewing Task Run History” on page 84. For information on locating the Link ID for a link, see “The Link Fields” on page 77.

6 Click OK.

Changing the Quality Center Synchronizer Password

You can change the password you use to log in to the Synchronizer server.

To change the Quality Center Synchronizer password:

1 In the Synchronizer client, choose Connection > Change Password. The Change Password dialog box opens.

2 In the Old password box, type the current password.

3 In the New password box, type the new password.

4 In the Retype password box, retype the new password.

5 Click OK to save your new password. A confirmation message displays and the Change Password dialog box closes.
Working with Rational ClearQuest

This appendix describes how to use Quality Center Synchronizer to work with synchronization links between Quality Center and Rational ClearQuest.

This appendix includes:
➤ Guidelines for Working with Rational ClearQuest on page 103
➤ Quality Center Synchronizer Settings for ClearQuest on page 108
➤ Migrating Links from the Mercury Quality Center Defects Synchronizer for Rational ClearQuest on page 110

Guidelines for Working with Rational ClearQuest

Before you begin using Quality Center Synchronizer with ClearQuest, make sure that you follow these guidelines to customize your Quality Center project and ClearQuest database:

➤ In ClearQuest, the Submitter field and the Submit_date field are given default values when an entity is created. It is recommended that you map the corresponding Quality Center fields to these fields to make sure that they contain the correct data. If these field are set as Read only, it is recommended that you set them to Mandatory to enable you to map data to them.

➤ ClearQuest’s default configuration imposes restrictions on the permissible state changes. This may prevent the Synchronizer from being able to synchronize the defect. For more information, see “Configuring the Permissible State Changes” on page 105.
The Synchronizer cannot mark ClearQuest defects as **Duplicate**, because
ClearQuest requires the ID of the duplicate defect, which the synchronizer is
not able to supply. For more information, see “Setting ClearQuest Defects as
Duplicate” on page 106.

The Synchronizer considers ClearQuest Submit, Modify and Delete actions
based on action type and not action name. Consider the following ways in
which the Synchronizer addresses issues related to action name and action
type:

- If no action of the type exists, the Synchronizer interprets this to mean
  that the user does not have permissions for this action type. This
generates an error during the Synchronizer integrity check.

- If there is more than one action of the type, one of the actions must have
  the default ClearQuest action name for the type. For example, if there are
two actions of the **SUBMIT** action type, the name of one of the actions
must be **Submit**. If none of the actions have the default action name, this
generates an error during the Synchronizer integrity check.
Configuring the Permissible State Changes

To synchronize records correctly according to the defined field mappings, Quality Center Synchronizer must be able to move a ClearQuest record from any state to any other state. However, ClearQuest places restrictions on state transitions. To enable Quality Center Synchronizer to make the necessary state transitions, you must add a new state called `SyncTmpAction`, which can be moved to and from any other state. Quality Center Synchronizer uses this state as a temporary state when performing state transitions.

To configure the permissible state changes:

1. Open the ClearQuest Designer. In the Actions screen, add the `SyncTmpAction` action name. Set the type to `CHANGE_STATE`.

2. In the State Transition Matrix screen, add a new state transition called `SyncTmpState`. You must configure it as shown below. In addition, the state should be assigned to the `Complete` state type. For more information on assigning a state to a state type, refer to the ClearQuest documentation.
3 In the Behaviors screen, configure **SyncTmpState**, ensuring that all fields except for **Headline** are configured as optional, as shown in the following example. The **Headline** field should be configured as mandatory for all states, including **SyncTmpState**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Submitted</th>
<th>Assigned</th>
<th>Queued</th>
<th>Resolved</th>
<th>Oozed</th>
<th>Duplicate</th>
<th>Postponed</th>
<th>To_Duplicate</th>
<th>SyncTmpState</th>
</tr>
</thead>
<tbody>
<tr>
<td>desc</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>in_active</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>time</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>defect</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>defect_num</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>defect_url</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>defectory</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>defecttype</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>headline</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
</tr>
<tr>
<td>description</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
</tr>
<tr>
<td>priority</td>
<td>OPTIONAL</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
</tr>
<tr>
<td>severity</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
</tr>
<tr>
<td>submitter</td>
<td>MANDATORY</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
</tr>
<tr>
<td>submit_date</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
</tr>
<tr>
<td>owner</td>
<td>OPTIONAL</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
<td>MANDATORY</td>
</tr>
<tr>
<td>opened</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>resolved</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>oozed</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>duplicate</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>postponed</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>todoremove</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
<td>READONLY</td>
</tr>
<tr>
<td>nnumber</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
<td>OPTIONAL</td>
</tr>
</tbody>
</table>

4 Check in the schema and upgrade the database.

**Setting ClearQuest Defects as Duplicate**

Quality Center Synchronizer cannot set the state of ClearQuest defects to **Duplicate** as ClearQuest requires the ID of the defect which is being duplicated to set the state of a defect to **Duplicate**. Quality Center Synchronizer is not able to determine from the Quality Center defect which defect is being duplicated.
To enable the Synchronizer to set the state of a ClearQuest defect to **Duplicate**, you must create a new state of type **CHANGE_STATE** and map defects to this state rather than to **Duplicate**.

**To create a new state for mapping duplicate defects:**

1. Open the ClearQuest Designer.
2. In the Actions window, add a new state, for example, **TD_Duplicate**.
Appendix A • Working with Rational ClearQuest

3 In the State Transition Matrix window, add and configure the state transition for the new state as shown in the image below. In addition, the state should be assigned to the Complete state type. For more information on assigning a state to a state type, refer to the ClearQuest documentation.

4 Check in the schema and upgrade the database.

5 In Quality Center Synchronizer, map Quality Center defects that represent duplicates to the state you create instead of to the state Duplicate.

Quality Center Synchronizer Settings for ClearQuest

This section describes the Quality Center Synchronizer settings that are specific to working with ClearQuest. This section includes the following topics:

➤ “ClearQuest Connection Properties” on page 109
➤ “ClearQuest Mandatory and Recommended Fields” on page 109
➤ “ClearQuest Adapter Parameters” on page 110
ClearQuest Connection Properties

The following settings are available when connecting to a ClearQuest endpoint. For more information on defining the connection settings to endpoints, see “Creating Links” on page 31.

➤ **User name.** The user name for a ClearQuest user. This user must have one or more of the following event permissions: defect creation, defect modification, and defect deletion. The permissions needed depend on the event options defined in the Events tab.

➤ **Password.** The password for the user you specified.

➤ **Database.** The ClearQuest user database that contains the data you want to synchronize with Quality Center.

➤ **SchemaRepository.** The schema repository containing the schema for the type of ClearQuest entity you want to synchronize.

ClearQuest Mandatory and Recommended Fields

Quality Center Synchronizer assigns one of the following levels to each field: **Mandatory**, **Recommended**, and **Optional**. For a ClearQuest endpoint, Quality Center Synchronizer assigns the level as follows:

➤ **Mandatory.** The field is required for records in the **Submitted** state.

➤ **Recommended.** The field is not required for records in the **Submitted** state, but is required for records of some other state.

➤ **Optional.** The field is not required for records in any state.

---

**Important:** When you create a record in ClearQuest with a particular state, you must assign values to all fields that are required for that state. Quality Center Synchronizer can create records in ClearQuest in any state, even without assigning values to all required fields for the state. However, to avoid the creation of records in ClearQuest that do not have values for all required fields, it is highly recommended that you map all **Recommended** fields in ClearQuest to fields in Quality Center.
ClearQuest Adapter Parameters

The **FieldsDependencyChain** parameter is available for a ClearQuest endpoint to control the order of field insertion into ClearQuest. This addresses the issue of a ClearQuest hook resetting a field value based on the value of another field.

You edit this parameter to define the order in which fields are updated in ClearQuest during synchronization. This enables the Synchronizer to update the field after the ClearQuest hook has reset it. For example, 

```
FieldsDependencyChain=Priority,Product,AssignedTo
```

For more information on Synchronizer adapter parameters, see “Setting Adapter Parameters” on page 71.

Migrating Links from the Mercury Quality Center Defects Synchronizer for Rational ClearQuest

If you created links for the Mercury Quality Center Defects Synchronizer for Rational ClearQuest (the ClearQuest Synchronizer), used with Quality Center 9.0 and earlier, you can migrate them to Quality Center Synchronizer using the ClearQuest Synchronizer Migration Tool.

The ClearQuest Synchronizer Migration Tool creates a compressed (.zip) file, which you can import into Quality Center Synchronizer in the same way as you import exported link data. For more information on importing link data, see “Importing Link Data” on page 98.

The resulting .zip file contains two XML files:

- An XML file containing configuration data for the link, such as field mapping data and link execution scheduling data.
- An XML file containing identity mapping data. This data is obtained by scanning the identity mapping data stored for the old link, stored in the Quality Center and ClearQuest databases. This scan may take some time.
This section includes the following topics:

➤ “Migration Notes and Limitations” on page 111
➤ “Overview of the Migration Process” on page 113
➤ “Migrating Links” on page 113

**Migration Notes and Limitations**

The following notes and limitations apply when you migrate links to Quality Center Synchronizer from the ClearQuest Synchronizer using the ClearQuest Synchronizer Migration Tool:

➤ You must run the ClearQuest Synchronizer Migration Tool on the same machine as the ClearQuest Synchronizer is installed.

➤ You should not make any changes in the ClearQuest and Quality Center projects included in a ClearQuest link between the time of the last synchronization using the ClearQuest Synchronizer and the first synchronization using Quality Center Synchronizer.

➤ Scheduling data from the ClearQuest Synchronizer link is migrated to Quality Center Synchronizer. However, when you import the link into Quality Center Synchronizer, the link is assigned to run manually only. To run the link automatically, you must edit the link’s settings. For more information on editing settings for a link see “Editing Synchronization Link Settings” on page 90.

➤ Only the first email notification address for the ClearQuest Synchronizer link is migrated to Quality Center Synchronizer.

➤ The option to ignore HTML formatting from the ClearQuest Synchronizer link is not migrated to Quality Center Synchronizer.

➤ Mappings between ClearQuest multi-line string fields and multi-value fields, and the Quality Center **Description** field are not migrated to Quality Center Synchronizer. For example, mappings from the **Notes_Log**, **Keywords**, **Note_Entry**, and **Symptoms** fields are not migrated. You must recreate equivalent mappings in Quality Center Synchronizer.
During the migration process, the ClearQuest Synchronizer Migration Tool performs a full scan on both the endpoints of the ClearQuest Synchronizer link to determine which identity mappings are found on each endpoint. The ClearQuest Synchronizer Migration Tool deals with the identity mappings it finds as follows:

- If the ClearQuest Synchronizer Migration Tool finds an identity mapping recorded on both endpoints, the mapping is included in the identity mapping XML file.

- If the ClearQuest Synchronizer Migration Tool finds duplicate mappings in an endpoint to a record in the other endpoint, it checks which of the mappings is consistent with the data in the second endpoint and includes only this mapping in the identity mapping XML file. It ignores the mapping that is inconsistent with the data in the second endpoint and writes a warning message to the migration log file.

  For example, suppose that ClearQuest defects with ID 10 and 20 both have the value 100 for the TD_ID field, which indicates that both these defects are mapped to the Quality Center defect with ID 100. If the Quality Center defect with ID 100 has value 20 for the CQ_ID field, the ClearQuest Synchronizer Migration Tool infers that the correct mapping is the mapping to the ClearQuest defect with ID 20, and includes only this mapping in the migration.

- If the ClearQuest Synchronizer Migration Tool finds an identity mapping recorded on only one endpoint, the mapping is included in the identity mapping XML file, but a warning message is included in the migration log file. Quality Center Synchronizer infers that the second record in the mapping (on which the mapping is not recorded) was deleted and handles the record as it would for regular deleted records.
Overview of the Migration Process

Migrating links to Quality Center Synchronizer from the ClearQuest Synchronizer consists of the following steps:

- **Run a synchronization.** Run a synchronization using the ClearQuest Synchronizer. Do not make any further changes in the ClearQuest or Quality Center projects.

- **Migrate links.** Migrate links from the ClearQuest Synchronizer using the ClearQuest Synchronizer Migration Tool. For more information, see “Migrating Links” on page 113.

- **Import links.** Import the migrated links into Quality Center Synchronizer. For more information, see “Importing Link Data” on page 98.

- **Restore additional link settings.** Re-define any additional link settings that were not migrated or restored by the Migration Tool, such as scheduling data. For more information, see “Migration Notes and Limitations” on page 111.

Migrating Links

You can migrate links from the Mercury Quality Center Defects Synchronizer for Rational ClearQuest.

To migrate a link:

1. Run the `CQSynchMigrator.exe` file, located on the Quality Center Synchronizer client machine under `<Quality Center Synchronizer Client>\CQSynchMigrator`. The ClearQuest Synchronizer Migration Tool opens.
Appendix A • Working with Rational ClearQuest

2 In the **Choose link to migrate** box, select the ClearQuest Synchronizer link that you want to migrate to Quality Center Synchronizer.

3 In the **Migrate link data into** box, type the name of the file to which you want the link data to be migrated. You can click the browse button to select a location.

4 Click the **Migrate link data** button. The migration process begins. At the end of the migration process, a confirmation message displays.
Working with Rational RequisitePro

This appendix describes notes and limitations specific to synchronizing requirements between Quality Center and Rational RequisitePro.

This appendix includes:
➤ Guidelines for Working with Rational RequisitePro on page 115
➤ RequisitePro Connection Properties on page 116
➤ Migrating to the Quality Center Synchronizer on page 117

Guidelines for Working with Rational RequisitePro

When working with the Synchronizer, make sure that you follow these guidelines:

➤ Record creation will fail during synchronization if you use the following characters when naming a requirement in Quality Center, or when naming a project, package, or requirement in RequisitePro: `\^ * : ‘`

➤ For synchronization with a RequisitePro project located on a network drive, the user configured to log on as a service for the Synchronizer must have permissions to access the network location.

➤ In Quality Center, if you want to move a requirement and make it a child of another requirement, make sure that you move it under a requirement of the same type. This is required because RequisitePro does not allow you to place a requirement of one type under a requirement of another type.

➤ RequisitePro Real, Time, and Userlist type fields are defined as String type in Synchronizer field mappings.
When synchronizing requirements, Quality Center adds the RequisitePro prefix tag as part of the requirement name.

When synchronizing requirements, if a RequisitePro Name field is empty, the Synchronizer uses the first 128 characters of the RequisitePro Text field instead. In addition, if the Name field contains any of the following characters, the Synchronizer replaces them with the underscore character: `\^*":`.

RequisitePro Connection Properties

The following settings are available when connecting to a RequisitePro endpoint. For more information on defining the connection settings to endpoints, see “Creating Links” on page 31.

- **User name.** The user name for a RequisitePro user. This user must have one or more of the following event permissions: requirement creation, requirement modification, and requirement deletion. The permissions needed depend on the event options defined in the Events tab.

- **Password.** The password for the user you specified.

- **Project.** The name of the project whose data you want to synchronize. The project must exist on the RequisitePro client machine. The project must also be visible for the user configured to log on to the Synchronizer as a service (included in the user’s RequisitePro catalog).
Migrating to the Quality Center Synchronizer

You use the Requirements Restore Tool to migrate from the Quality Center Requirements Synchronizer for Rational RequisitePro to the latest version of the Quality Center Synchronizer. The Requirements Restore Tool can be used with Quality Center 9.2 and later.

For information on the advantages of upgrading to the Quality Center Synchronizer, refer to the HP Quality Center Synchronizer Readme and navigate to “What’s New for Rational RequisitePro Users”.

This section includes the following topics:

➤ “Overview of the Migration Process” on page 117
➤ “Instructions for Migrating” on page 119

Overview of the Migration Process

Migrating to the latest version of the Quality Center Synchronizer consists of the following steps:

➤ Run a full synchronization using the Quality Center Requirements Synchronizer for Rational RequisitePro. Run a full synchronization using the Quality Center Requirements Synchronizer for Rational RequisitePro 9.0 to ensure that all requirements are up to date.

➤ Back up requirements in Quality Center. Create a backup of the requirements that you synchronized using the Quality Center Requirements Synchronizer for Rational RequisitePro by renaming the top-level requirement.

➤ Create a new synchronization link using the Quality Center Synchronizer. Create a synchronization link for the requirements you want to synchronize between RequisitePro and Quality Center.

➤ Run a full synchronization using the Quality Center Synchronizer. Run a full synchronization task for the new link you created. Verify that all requirements are recreated in Quality Center.
Appendix B • Working with Rational RequisitePro

- **Run the Requirements Restore Tool.** Requirements in Quality Center can contain additional data that does not exist in corresponding requirements in RequisitePro. When you run the new synchronization link to recreate requirements in Quality Center, that data is absent, and needs to be restored from the requirements you backed up.

  The following data is restored by the Requirements Restore Tool to the newly created requirements in Quality Center:
  - Associations between other requirements, defects, and tests. Coverage status is then automatically updated.
  - Attachments.
  - Target Cycle and Target Release fields.

The following data is **not** restored:
- History.
- Rich text.
- When you run the new Quality Center Synchronizer link, each requirement is created with a new Req ID. Links to the backed up requirements that were created using the Copy URL function and filters based on the Req ID field will no longer work.
- Quality Center fields that were not previously synchronized, such as risk based testing fields and user-defined fields.

  **Note:** If you have Quality Center fields that are not synchronized by the Quality Center Requirements Synchronizer for Rational RequisitePro, such as risk-based testing and user-defined fields, the fields will no longer available after restoration unless you do the following:

Before you run the full synchronization using the Quality Center Requirements Synchronizer for Rational RequisitePro in step 1 of the migration process (described on page 119), you need to add mappings for these fields to the RequisitePro Synchronizer task. You map the fields in the new Quality Center Synchronizer link you create in step 3 (described on page 120). After the restoration process is complete, you can delete the field mappings from your Quality Center Synchronizer link.
Appendix B • Working with Rational RequisitePro

Instructions for Migrating

This section describes how to migrate from the Quality Center Requirements Synchronizer for Rational RequisitePro to Quality Center Synchronizer version 1.20.

To migrate to the new Quality Center Synchronizer:

1 Open the Quality Center Requirements Synchronizer for Rational RequisitePro 9.0 and run a full synchronization for each task in your RequisitePro project.

Note: After synchronizing, do not make any changes to the requirements tree structure in RequisitePro or Quality Center.

2 In Quality Center, in the Requirements module, rename the top-level requirement containing the requirements for the RequisitePro project you synchronized. This becomes the backup folder. For example, in the following illustration, you can rename Project 1 to BACKUP: Project 1.
**Note:** Do not copy the requirements. The requirements must be renamed or moved to maintain associations between other requirements, defects, and tests.

3 Using Quality Center Synchronizer, create a requirements synchronization link.

4 Using Quality Center Synchronizer, run a full synchronization task for the link you created. Verify that all the requirements are created in Quality Center.

For example, in the following illustration, the Requirements Tree now displays Project 1, containing the requirements synchronized using Quality Center Synchronizer. BACKUP: Project 1 contains the requirements synchronized using Quality Center Requirements Synchronizer for Rational RequisitePro.
Appendix B • Working with Rational RequisitePro

5 Run the `QCRequirementsRestoreTool.exe` file. The Quality Center Requirements Restore Tool dialog box opens.

6 Under **Quality Center Connection**, click **Set** to specify login information for connecting to Quality Center. The Quality Center Connection dialog box opens.
In the **Server URL** box, type the URL for the Quality Center server in the following format: \( \text{http://<Quality Center server name>[<:port number>]}\text{/qcbin} \). Click **Connect**. The Authenticate Quality Center User options are enabled.

In the **Login Name** box, type the user name for a Quality Center user. In the **Password** box, type the Quality Center password for the user. Click **Authenticate**. The Log in to Quality Center Project options are enabled.

In the **Domain** and **Project** boxes, select the domain and project for which you are synchronizing requirements and click **Login**.

Click **OK** to close the Quality Center Connection dialog box.

In the Quality Center Requirements Restore Tool dialog box, under **Backup folder location**, type the path of the Quality Center backup folder you defined in step 2.

Under **New folder location**, type the path of the folder containing the requirements synchronized using the new Quality Center Synchronizer link in step 3.

Click **Analyze** to verify that each requirement in the backup folder has a corresponding requirement in the new folder. The Requirements Restore Tool Process dialog box opens and displays progress. When the process completes, click **View Log** to view the log file. If hierarchical inconsistencies occur, you must manually fix them in the backup folder you defined in step 2.

Click **Restore** to run the Requirements Restore Tool process and restore requirements data. The Requirements Restore Tool Process dialog box opens and displays progress. When the process completes, click **View Log** to view the log file, or **Close** to close the Requirements Restore Tool Process dialog box.

---

**Note:** If restoration fails, you can resolve any issues and then run **Restore** again to complete the process.

---

To access the log files created by the Analyze and Restore processes, from the Quality Center Requirements Restore Tool dialog box, select **File > Log Directory**.
16 Click **Close** to close the Requirements Restore Tool.

17 After running the Requirements Restore Tool, associations to the backed up requirements remain. Verify that all requirements are synchronized and all associations are restored and then delete the back up folder.

---

**Note:** If you delete the backup folder, the history, rich text, and any additional data that was not restored will no longer be available.